
After VideoFactory is installed and you start it for the first time, the registration wizard will 
appear. This wizard offers easy steps that enable you to register VideoFactory online with 
Sonic Foundry. Alternatively, you may register VideoFactory online at 
www.sonicfoundry.com at anytime. 

Registering your product will provide you with exclusive access to a variety of technical 
support options, notification of product updates, and special promotions exclusive only to 
VideoFactory registered users. 

 Registration Assistance

If you do not have access to the Internet, registration assistance is available. Please contact 
our Customer Service Department. 

Registration assistance is currently available during normal office hours by dialing the 
following numbers:

Telephone/Fax Country
1-800-577-6642 (toll-free) US, Canada, and Virgin Islands

+800-000-76642 (toll-free) Australia, Denmark, France, Germany, Italy, Sweden, UK, 
Netherlands, and Japan

+608-204-7703 for all other countries

1-608-250-1745 (Fax) All countries



Customer Service/Sales

For a detailed list of Customer Service options, we encourage you to visit 
www.sonicfoundry.com. Telephone support during normal office hours:

Technical Support

For a detailed list of Technical Support options, we encourage you to visit 
www.sonicfoundry.com/support.

• To listen to your support options please call 608-256-5555.  

The information contained in this manual is subject to change without notice and does not 
represent a commitment on the part of Sonic Foundry. The software described in this 
manual is provided under the terms of a license agreement or non-disclosure agreement. The 
software license agreement specifies the terms and conditions for its lawful use. No part of 
this manual may be reproduced or transmitted in any form or by any means for any purpose 
other than the purchaser’s personal use, without written permission from Sonic Foundry, 
Inc.

Sonic Foundry and VideoFactory are trademarks of Sonic Foundry, Inc. The brands and 
products named here are the trademarks or registered trademarks of Sonic Foundry, its 
affiliates, or their respective holders.

© 1999-2001 Sonic Foundry, Inc.

Telephone/Fax/E-mail Country
1-800-577-6642 (toll-free) US, Canada, and Virgin Islands

+800-000-76642 (toll-free) Australia, Denmark, France, Germany, Italy, Sweden, UK, 
Netherlands, and Japan

+608-204-7703 for all other countries

1-608-250-1745 (Fax) All countries

customerservice@sonicfoundry.com

Sonic Foundry, Inc.
1617 Sherman Avenue
Madison, WI  53704 
USA



3

Table of Contents

1. Introduction. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7

Welcome to Sonic Foundry VideoFactory™. . . . . . . . . . . . . . . . . . . . . . . 7

System requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Installing VideoFactory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Starting VideoFactory. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Registration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

2. Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19
Projects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

Capturing video media. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Files and events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Events basics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Track basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Playback and preview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

3. Basic Editing Techniques . . . . . . . . . . . . . . . . . . . . . . . .35
Getting around. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Making selections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Grouping events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Basic event editing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Crossfading events . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Undo and Redo commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47



4

4. Advanced Editing Techniques . . . . . . . . . . . . . . . . . . .49
Ripple editing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Project markers and regions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Time compressing/stretching. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Takes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Trimmer window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Mixer window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Accessing event properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Event switches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Audio event envelopes (ASR). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Audio track envelopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

5. Advanced Video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69
Pan/Crop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Working with images. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Scrolling titles - Pan/Crop technique. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Optimizing previews. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

6. Recording Audio and Audio FX . . . . . . . . . . . . . . . . . .77
Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Specifying where recordings are stored . . . . . . . . . . . . . . . . . . . . . . . . . 81

Using an external sound editing program. . . . . . . . . . . . . . . . . . . . . . . . 81

Using audio track FX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Audio effects dictionary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

7. Video Transitions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .89
Transitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89



5

Transition effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Video transition dictionary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

8. Video FX. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101
Video FX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Modifying FX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Video FX dictionary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

9. Saving and Rendering Projects. . . . . . . . . . . . . . . . . 113
Rendering projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113

Using rendering format controls and templates . . . . . . . . . . . . . . . . . 116

Customizing a render . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

Custom rendering settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Selecting a video format . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119



6



CHP. 1

CHAPTER
7

1

Introduction
Welcome to Sonic Foundry VideoFactory™

Sonic Foundry VideoFactory is an innovative and advanced video editing system. 
VideoFactory was designed to create an efficient audio/video production environment 
without sacrificing the quality and processing power that you expect from Sonic Foundry. 

VideoFactory removes the barriers commonly found between your creativity and 
sophisticated multitrack audio/video editing systems. Whether it’s the standard and familiar 
Windows navigation commands or the clean and uncluttered interface throughout, you’ll 
find VideoFactory to be a tool that will be mastered in minutes. But don’t let that fool you. 
Beneath the unique and customizable interface, you’ll find a product so powerful and 
flexible, you’ll forget you’ve just completed your project in half the time. This table lists 
some of the features available in VideoFactory:

Nondestructive editing Two video and three audio tracks 
Unlimited undo/redo Multiple file formats on a single track
Quick-edit media trimmer with direct link to 
*.wav editor

ExpressFX available on every audio track

Loop recording Numerous Video special effect and transitions
Real time event resampling Dual processor support
Audio/video scrub control Dual monitor support
Video Preview window Ability to incorporate timeline metadata (markers/

captions) for Internet content authoring
Automatic crossfades between video media and 
between audio media

Exports: .wav, .wma, .wmv, .rm, .mov, .w64

16-bit/48 kHz Internet streaming file authoring (Windows Media 
Technologies and RealMedia)
Imports: .wav, .aif,  .avi, .mp3, .mov, .qt, .bmp, .jpg, 
.png, .tga, .psd
INTRODUCTION
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System requirements

Minimum requirements

• Microsoft® Windows™ 98SE, Me, or 2000
• CD-ROM drive
• 40 MB hard-disk space for program installation
• Windows-compatible sound card
•  Internet Explorer™ 4.0 (included on CD-ROM) or later to view online Help 
• 400 MHz processor
• 128 MB RAM
• 16-bit color display

Installing VideoFactory

To install VideoFactory:

1. Insert the VideoFactory CD-ROM. The VideoFactory Installation screen appears (if CD-
ROM AutoPlay is enabled).

If CD-ROM AutoPlay is disabled, click on the  button and choose Run. In the Run 
window that appears, type the CD-ROM drive’s letter and add :\setup.exe. Click the OK 
button to start the installation.

2. Click Install Software. The installation process begins.

3. Follow the screen prompts and enter the necessary information when required. 

4. At the last screen prompt, click  to conclude the installation.

Note: VideoFactory uses a Windows 2000 
installer for all versions of Windows (e.g. 
98SE). VideoFactory will install the Windows 
2000 installer and then ask you to restart your 
system.

Starting VideoFactory

After VideoFactory has been installed on your computer, there are two ways to start the 
program. 
INTRODUCTION CHP. 1
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Using the shortcut VideoFactory

Double-click the VideoFactory icon  on your desktop upon completion of the 
installation procedure. This icon is a shortcut to the VideoFactory program located on your 
hard drive.

Using the Start button

The second method also allows you to start VideoFactory right from the desktop.

1. Click the  button on the Taskbar. The Start menu appears.

2. From the Start menu, choose Programs.

3. From the Programs menu, choose Sonic Foundry.

4. From the submenu, select the VideoFactory program group and choose VideoFactory to 
start the program. 

The registration dialog window appears the first time you run VideoFactory. Once you have 
registered, this will not appear again.

Registration

You must register VideoFactory within seven (7) days in order to continue using the product. 
The registration dialog that appears when you start VideoFactory allows you to quickly and 
easily register:

• Register online - instantly registers the product over the Internet.
• Register by phone - call Sonic Foundry to register manually.
• Register online from another computer - if the computer VideoFactory is installed on 

does not have an Internet connection, but you have another computer that does.
• Not register at this time - allows you to continue using VideoFactory for a limited time 

without registering.

This graphic displays the default Start Menu location where VideoFactory was 
installed. If you specified a different location during installation, navigate
to that menu location via this menu.
CHP. 1 INTRODUCTION
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Help

VideoFactory includes a number of resources to help you as you work. Besides this manual, 
there is a detailed online Help system, a Getting Started Tutorial, Web pages at Sonic 
Foundry’s Wed site, and an entire CD containing sample media to stimulate your creativity.

Accessing the online Help

The online Help is available in two forms: in a Main Help window or What’s This? Help 
window. Both forms are available via the keyboard ( ) or by clicking the Help menu.

Main Help window

The Main Help window is accessed either by choosing Contents or Index from the Help 
menu or by pressing the  key. This window has three tabs that you can use to find the 
information that you need.

The Contents tab provides a list of available help topics. Click on a closed book ( ) to open 
the pages, and then on the topic page ( ) that you want information about.

The Index tab provides a complete listing of the Help topics available. Scroll through the list 
of available topics or type a word in the text field to quickly locate topics related to that 
word. Select the topic and click the  button.

The Search tab allows you to enter a keyword and display all of the topics in the online Help 
that contain the keyword you have entered. Type a keyword in the text field and click on 
the  button. Select the topic from the list and click the  button.

What’s This? Help

What’s This? Help allows you to view pop-up descriptions of VideoFactory menus, buttons, 
and dialog boxes.

To use What’s This? Help: 

1. Click on the question mark ( ) in the upper right-hand corner of the dialog box or 
program workspace. Alternately, you can choose What's This? from the Help menu or 
press the  keys. 

2. The cursor changes to a question mark icon: ( ).

3. Click on an item in the program’s interface.

F1

F1

Shift + F1
INTRODUCTION CHP. 1
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VideoFactory Getting Started Tutorial

VideoFactory utilizes a Getting Started Tutorial feature that walks you through the basics of 
any project. This guide is displayed every time you run VideoFactory; select Don’t show me 
this again to turn this feature off.

Tip of the Day

The Tip of the Day displays functional tips to increase your productivity with VideoFactory. 
To view and scroll through the Tip of the Day messages, choose Tip of the Day from the Help 
menu. The Tip of the Day will not appear when the Getting Started Tutorial is active.

PDF manual

There is a *.pdf version of the manual available on the VideoFactory CD-ROM. The PDF 
version of the manual may contain some information that was written after this manual 
went to press. To view this manual, you will need Adobe® Acrobat® Reader (also included 
on the VideoFactory CD-ROM). Please read the VideoFactory_readme.doc for more 
information on the latest updates and changes.

Help on the Web

Additional VideoFactory help and information is available on the Sonic Foundry Web site. 
From the Help menu choose Sonic Foundry on the Web to view a listing of Web pages 
pertaining to VideoFactory and Sonic Foundry.
CHP. 1 INTRODUCTION
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Overview

VideoFactory is designed to be an easy-to-use program with many tools that provide power 
and flexibility when creating and working with multimedia files. As you will learn, many of 
the VideoFactory operations, menu items, and shortcut keys are consistent with other 
popular Windows software applications. The following sections are a graphical tour of the 
VideoFactory workspace. Please take a moment to get familiar with the VideoFactory 
interface. Many of the procedures in this manual use terminology that is defined in these 
sections.

Menu Bar
Toolbar

Time Display

Track 

Scrub Control

Window
Docking 
Area

Header

Marker Bar

Ruler

Track View

Transport Bar

(timeline)

Preview Window

Status Bar
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Toolbar

The Toolbar allows you to quickly access the most commonly used functions and features in 
VideoFactory.

Marker bar

The Marker bar is the area where informational tags may be placed, named, and positioned 
along the project’s timeline. These can serve as cues or reminders highlighting important 
events in your project.

Create new project Enable ripple edits

Open existing project Lock Envelopes

Save project Ignore Event Grouping

Open project properties Edit tool

Cut selected events or time range Envelope tool

Copy selected events or time range Selection tool

Paste items from clipboard into project Zoom tool

Undo command Open Video Capture

Redo command Text tool

Enable snapping to grid lines Browse for Media on the Web

Enable automatic crossfades What’s This? Help
CHP. 1 INTRODUCTION
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Track Header

This area identifies the track order in your project and contains controls used to determine 
audio track mixing.

Track View (timeline)

All arranging and editing is done in the Track View (timeline). This area contains all the 
project’s events.

Transport bar controls

The Transport bar contains the playback and cursor positioning buttons frequently used 
while working on and previewing your project.

Loop playback Move cursor to start of project

Play from beginning of project Move cursor to end of project

Play project from cursor position Move cursor left at grid increments

Pause project playback Move cursor right at grid increments

Stop playback

Track Number

Track mode
controls

Video Tracks

Audio Track

Scribble Strip

Track View
INTRODUCTION CHP. 1
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Status bar

The Status bar is located at the bottom of the main program window and displays 
information about roughly how much space is left on your computer to record audio (Record 
Time). During rendering processes, the left side of the Status bar also contains information 
about the progress of the render.

The Video Preview window also has its own status bar that displays project specific 
information.

Scrub control

The Scrub control is used to play your project forward or backward for editing purposes. You 
may adjust playback speed by setting the Speed Control Marker located beneath the Scrub 
control.

Window Docking Area

This area allows you to keep frequently used windows available, but out of the way while you 
are working with a project. To dock a window, simply drag it to the Docking Area. When 
windows are docked, they are stacked on top of one another. Each window has a tab at the 
bottom with its name on it. Click the window’s tab to bring it to the top. Drag the handle on 
the left side of a docked window to remove a window from the Docking Area and float it.

Set play-

Click and drag either forward

back speed

or backward for playback

Drag handle to float window.
CHP. 1 INTRODUCTION
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Explorer window - Alt+1

The media Explorer window is similar to the Windows Explorer. Use the VideoFactory 
Explorer window to select media files to place into your projects.

Trimmer window - Alt+2

The Trimmer window is a good place to edit any media file. When a media file is placed in 
the Trimmer window, you may take portions of the event and place them on separate tracks 
by dragging and dropping. For more information, see Trimmer window on page 57.

Mixer window - Alt+3

The Mixer window gives you access to your project’s audio properties and output levels. 

Select drive Preview selected
media file before
you place it
in the project

or folder

Select media to place 
in the project by dragging
and dropping or 
double-clicking

Trimmer window
Transport bar

Right-click on a 
meter to change
its settings
INTRODUCTION CHP. 1
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Video Preview window - Alt+6

This window displays a project’s video event during project editing and playback.

Transitions window - Alt+8

The Transitions window contains all of the transitions available in VideoFactory. The 
thumbnails display animated examples of each transition and preset. Transitions can be 
dragged from this window to the edge of an event or between two video events. For more 
information, see Transitions on page 89.

Video will appear during
project playback or as
the cursor is moved 
during editing.

Right-click to 
change Video
Preview settings
CHP. 1 INTRODUCTION
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Video FX window - Alt+9

This window displays all of the controls needed to customize the effects. The specific 
controls that are available depend on the selected effect.
INTRODUCTION CHP. 1
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Getting Started
VideoFactory is a new way of thinking about multimedia productions. Whether you are an 
experienced multimedia author or a budding novice, you will find VideoFactory easy to use 
and powerful.

Projects

The process of creating multimedia productions can be an extremely complicated 
undertaking, involving hundreds of shots, takes, voiceovers, music beds, and special effects. 
Organization quickly becomes a critical issue in this process. In VideoFactory, organization is 
handled by a small project file (*.vf) that saves the relevant information about source file 
locations, edits, cuts, insertion points, transitions, and special effects. This project file is not 
a multimedia file, but is instead used to create the final file when editing is finished.

The greatest advantage of working with projects is not the organizational benefits, however, 
but the fact that you are working on, and editing, a project file, and not the original source 
files. When you copy, cut, paste, trim, and otherwise edit your movie, the process is 
nondestructive. You can edit without worrying about corrupting your source files. This not 
only gives you a strong sense of security, but it also gives you the freedom to experiment.

To create a new project:

1. From the File menu, choose New. The first time you run VideoFactory, a new project will 
automatically be started for you.

2. Enter your project settings on the various tabs:
GETTING STARTED
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• Summary - Enter any relevant information 
and reminders about your project. 

• Audio - Set up the basic audio settings.
• Video - Select the format and other video 

parameters.

3. Click OK.

4. From the File menu, choose Save. Enter a 
name, browse for a location, and click the Save 
button to save your project (*.vf file).

The project settings determined in step 3 can be 
changed at any time while you are working on a 
project. From the File menu, choose Properties to 
change any of these settings. These settings 
automatically determine the overall quality of the 
rendering (creation) of your final video. Carefully setting up the properties at the beginning 
of your project will save a significant amount of time later. You can override these settings 
when you are ready to render the final movie.

Determining a project’s properties

There is another method for determining the correct properties for your project. Since the 
only way to maintain 100% quality is to match the project’s properties to the final output 
properties, video files that have been captured to your hard disk from your camcorder already 
contain all of the necessary information.

To determine a project’s properties from a video file:

1. From the File menu, choose Properties.

2. In the Project Properties dialog, click the Match Media Settings button ( ).

3. Browse for a file that has been captured from your camcorder. This file should be 
unaltered and unedited in any way.

4. Click OK.

VideoFactory will automatically detect the frame size, frame rate, pixel aspect ratio, and field 
order of this file and set the Project Properties to match. In the Project Properties dialog, 
enter a name for a Template and click the Save button ( ) to save this information for 
future use.
GETTING STARTED CHP. 2
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Saving the project

When you save your work, it is saved in a project file (*.vf). Project files are not a rendered 
media files. The first time a project is saved you will have two options. The one you select 
will affect the project’s file size and its portability.

To save the project:

1. Select one of the following save methods:

• From the File menu, choose Save.
• Click the Save button ( ). 
• Press  on the keyboard.

The first time you save a project, the Save As dialog appears.

In subsequent saves, the above dialog is bypassed, your existing file name is retained, and 
your project is updated to include any implemented changes.

2. Select the drive and folder where you want to store the project.

3. Type the project name in the File Name field.

4. Click the Copy all media with project check box if you 
want to have all the media copied into the same 
folder as the project.

5. Click Save.

Capturing video media

Getting video media onto your computer can be more complex than simply recording an 
audio file. The VideoFactory Video software package therefore includes an independent 
Video Capture application that can be used to capture video from you camcorder or other 
video source to your computer. To run this application, click the Launch Video Capture 
button ( ) on the toolbar in VideoFactory. For more information, please consult the 
manual and Help that is included with this application.

Format Extension Definition
VideoFactory Project *.vf Saves all of the information about a single project. This file format does not contain any 

media. It saves the references to media files used in the project and project information, 
such as track FX, envelopes, bus assignments, and output properties. 

VideoFactory Project 
with External Media

*.vf When the Copy all media with project is selected, all of the media in the project will 
be copied into the same folder as the project file. This option makes transporting the 
project easy and convenient.

Ctrl + S
CHP. 2 GETTING STARTED
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Files and events

The objects you work with in VideoFactory are referred to as media files and events. Tracks 
are timeline containers where events are placed and arranged.

• Files are objects that are stored on your hard disk. In VideoFactory, you will mostly be 
working with media files, such as music and video files. VideoFactory does not operate on, 
nor change files physically. Files can be accessed from VideoFactory Explorer.

• Events are periods of time on the timeline in VideoFactory that act as windows into 
media files. When dragging a media file onto the timeline, you are automatically creating 
an event that contains that file’s contents. An event can contain video, audio, still 
images, and some special generated media. The event window may only contain a small 
portion of a much larger media file. A single media file can be used repeatedly to create 
any number of different events, since each event can be trimmed independently.

Media files (e.g. *.wav or *.avi) are on your computer’s hard drive and can be accessed from 
Windows Explorer or from VideoFactory’ Explorer. Events contain media files, are the most 
basic unit of editing in VideoFactory, and can be found on the timeline.

Finding media files to use

Media files can be located and inserted into a VideoFactory project by using the 
VideoFactory Explorer window, clicking the File menu and choosing Open or dragged 
directly from Windows Explorer. Many types of video, still image, and audio files formats are 
supported.

The original media file.

An event trimmed from the original media file.

The event as it appears in VideoFactory.
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VideoFactory Explorer window

The media Explorer window in VideoFactory is similar to the Windows file management 
Explorer. You can expand and collapse drives and folders in the tree view. The contents of 
selected drives and folders appears in the list view.

Note: If you cannot see the Explorer window, 
it may be under another window. Click the 
Explorer tab at the bottom of the workspace to 
display the window. If you do not see the 
Explorer tab, from the View menu, choose 
Explorer to display it.

Using the VideoFactory Explorer allows you to place multiple file types into your project 
simultaneously. 

To find media using the Explorer window:

1. From the drop-down list or tree view, choose the drive or folder 
where the media is located.

Note: VideoFactory is preset to display all 
supported file types. However, you may 
change the list view to display all files within a 
selected drive or folder.

2. From the list view, you may place the file into your project by dragging and dropping or 
double-clicking it.

Change view button

Auto-preview button
Stop preview button

Play preview button
Add to favorites folder

Delete selected items
Create new folder

Refresh view
Move up tree

Tree view List view

Browse for Media on Web button

VideoFactory windows are dockable. To access
a hidden window, click its tab to bring 
it forward.
CHP. 2 GETTING STARTED



24
You can also select files by choosing the Open command on the File menu, or by clicking the 
Open button ( ) on the Toolbar.

Previewing a media file

Once you have located media files, you may preview them before placing them in your 
project. The Explorer window has a mini-transport bar with Play, Stop, and Auto Preview 
buttons ( ). 

When you preview a file, its stream is sent to the Mixer window’s preview bus (for audio 
files) or to the Video Preview window (for video files).

To preview a media file:

1. Select an event in the list view.

2. Click the Play button ( ) to listen to the file.

3. Click the Stop button ( ), select a different file, or place the file in the project to stop 
previewing to the file.

Note: To automatically preview selections, 
click the Auto Preview button ( ) on the 
Explorer’s Transport bar.

When a media file is placed on a track, one or more events are created that contain, or 
reference, the entire media file. Each track can contain more that one event. Events can be 
trimmed to contain only part of a larger media file.There are two basic types of tracks: audio 
and video.You may place events on separate tracks, or place all events of a similar media type 
(audio or video) on the same track. Video tracks have different controls and features, but 
video events and tracks behave in a similar way to audio events and tracks. If a video file has 
associated audio, VideoFactory places this audio into the nearest available audio track.

Two events that contain the video (top)
and audio streams from a single 
multimedia video file, each inserted on
a separate track.
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Events basics

Events are the most basic objects in a project in VideoFactory. An event is something that 
happens in time, has a specific duration, and can be video or audio. In VideoFactory, there 
are two primary types of events: audio events and video events. 

Audio events are created from audio files on your computer (e.g. *.wav or *.mp3) or can be 
a part of a video file (e.g. *.avi). An audio event can contain an entire audio file or only a 
portion of it. It can be modified with effects to change many of its characteristics, such as 
speed, volume and equalization. Audio events can be mixed with other audio events.

Video events are created from video files captured to your computer (typically *.avi, *.mov, 
or *.qt) or images (*.bmp, *.jpg, *.png, *.tga or *.tif). A video event can be the whole file or 
a small section of that file. It can be modified with FX to change many of its characteristics, 
such as speed, color, and size. Video events can appear on top of or overlay other video 
events. Overlays can be video files, still images, titles or other graphics and logos.

Inserting media

After you have located the media that you want to use in your project using the Media 
Explorer, the next step is to insert it onto the timeline. A media file that has been inserted 
onto the VideoFactory timeline is called an event. Video and other image files must be 
inserted into one of the two video tracks while music and sound files must be inserted into 
one of the three audio tracks. For more information, see Track basics on page 28.

Media files may be inserted into your project by double-clicking them or by dragging them. 
Either method places the media file in an event in its entirety in the Track View. After the 
file is placed, it becomes an event along the project’s timeline. At this point, the contents of 
the event and the media file are identical.

Drag-and-drop or double-clicking an event

Video event placement is the same as placing an audio event; drag-and-drop controls 
timeline placement and double-clicking places the event at the cursor’s position. 

Media files with video frequently include associated audio. When you insert a media file into 
the timeline, the associated audio is automatically inserted into a separate audio track below 
the video track. The two associated events are grouped together and behave as a single unit 
when moved or otherwise edited.

To place multiple events:

1. Select multiple events in the Media Explorer or the Media Pool. Select a range of 
adjacent media files by holding down the  key and clicking files in the list view or 
select files that are not adjacent by holding down the  key and clicking files.

2. Right-click and drag the files to the Track View (timeline).

Shift

Ctrl
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3. Before you drop the files, select a placement option from the pop-up 
menu.

• Add Across Time

• Add As Takes

For more information, see Working with multiple recorded takes on page 234.

• Video Only and Audio Only allow you to isolate either the video or audio, and add that 
stream from a multimedia file either across time or as takes.

Note: A left-click drag-and-drop 
automatically inserts the events across time. 
The various modes can also be cycled through 
by right-clicking (without releasing the left 
mouse button) while performing the drag-and-
drop operation.

Moving events along the timeline

Events may be moved along the timeline individually or as a group. The left edge of an event 
is its starting point. Therefore, where the left edge lines up on the ruler determines when the 
event starts. 

Events may overlap each other or be placed on top of each other.

Moving a single event

You can move an event along the timeline within a track or move it to a different track.

To move an event:

1. Select the event by clicking on it. The event is highlighted in the track’s color.

2. Drag the event along the timeline. 

You will see one event on the track.
The other events are listed at takes beneath the 
the topmost event.
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If you move the event along the original track’s timeline, the 
event’s appearance (color) remains the same.

However, you may move the event to a 
different track. When you do, the event 
appears as a simple outline and you will 
see its original track and position on the 
timeline. 

Moving multiple events

You can move multiple events along the timeline within a track or move them to a different 
track, similar to the previous procedure. In addition, selected events do not need to be 
within the same track. You may select events on different tracks and move them as a group 
along the timeline.

To move multiple events:

1. Use the  key, the  key, or the Selection Edit tool ( ) to select the events. For 
more information, see Selecting multiple events on page 37.

2. Place the mouse cursor over one of the selected events.

3. Drag the events along their respective timelines.

To more precisely move an event, your can nudge it by clicking on the event on the timeline 
and pressing “4” and “6” on the number pad on your keyboard to bump it one small unit at a 
time. The amount of movement caused by each nudge is determined by how far the timeline 
is zoomed in or out. If you zoom in far enough, each nudge can move the event one frame of 
video at a time or even less. 

Original track position

New track and position

Ctrl Shift
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Track basics

VideoFactory has five basic tracks that are used to lay out and organize your video project. 
There are two video tracks to contain the visual elements (e.g. video, images, titles) and 
three audio tracks for audio elements (e.g. ambient sounds, music, narration).

The five tracks start out with preset names to indicate typical usage. These names can easily 
be changed and the tracks can be used in whatever way works for you.

• Video Overlay - Anything in this video track appears over or on top of the second track. 
This track is designed to allow you to put titles, logos and other overlay graphics into your 
project. Images and video can also be put into this track, but any media in the overlay 
track that is not at least partially transparent will completely obscure anything in the 
second track.

• Video - This is designed to be the primary video track. This track always appears below or 
under the first video track and may be completely covered by any media in that track.

• Voice - The three audio tracks are identical in nature and do not have a particular 
hierarchy. The names are only suggestive of function. The voice track may be used for 
narrations and voiceovers.

• Music - The music track can be used for background music.
• Sound Effects - This track can be used for adding sound effects or foley art.
Once an event is placed on a track, VideoFactory automatically displays track controls that 
you can use to affect the event or events contained within the track. The following 
illustration shows the track controls for an audio track.
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Toggling the track size

You may change an individual track’s height in the Track View by clicking the View buttons 
( , , ) on the track. Alternatively, you may use the +  or  shortcut keys to 
toggle through different track-height settings. The shortcut keys affect all tracks in your 
project and make them the same height. You may resize a track by dragging the bottom 
border. 

Scrolling and zooming

Scrolling and zooming in the workspace is easy. 

• Click the scroll bar arrows in VideoFactory to move up and down the tracks or move 
forward and back along the timeline. 

• Drag the scroll bars to move up and down the tracks or move forward and back along the 
timeline.

• Click the Zoom tools ( ) to reveal more or less of the timeline. 

Click Track height

Track Track 
Effects

Record

View

Mute

Solonumber Scribble Strip

Ctrl + Shift 
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• Drag the edge of the scroll bar, as a zooming shortcut or 
press the up ( ) and down ( ) arrow keys.

• Click the Zoom Edit Tool ( ) button or, from the Edit 
menu, choose Editing Tool and then choose Zoom. In 
this mode, drag on the timeline to draw a rectangle that 
defines the zoom region.

Zooming directly controls the accuracy of your editing. 
Each video event has thumbnail representations of the frames within the event. Depending 
on how far you have zoomed in on a video event, this thumbnail can be one image 
representing the entire event, or every frame can be displayed as a thumbnail. The first and 
last thumbnails always represent the first and last frames of video in an event.

VideoFactory also has mouse scroll wheel support. The behavior of the wheel depends on 
the position of the cursor in the workspace.

• The default behavior of the Wheel is to zoom horizontally.
• Shift+Wheel scrolls horizontally (through time).
• Ctrl+Wheel moves the trackview cursor in small increments.
• Ctrl+Shift+Alt+Wheel moves the cursor in one-frame increments.
• Pressing the mouse wheel activates auto-panning.

To change a track’s color:

1. In the Track Header, right-click on a track to display a shortcut menu.

2. From the shortcut menu, choose Track Color to display a submenu.

3. From the submenu, select a color.

Mute button

This button enables you to temporarily disable playback of the track, so you can focus on 
other tracks. When a track is muted, it appears grayed out on the Track View. 

Before muting the track After muting the track
GETTING STARTED CHP. 2



31
Scribble Strip

This area lets you label a track. Double-click in the strip and type the track’s name or right-
click anywhere in the Track Header and choose Rename from the shortcut menu and then 
type the track’s name. If you do not see the Scribble Strip, change the track’s height or 
width.

Volume fader

This fader controls an audio track volume relative to the other tracks when it is played back. 
VideoFactory audio tracks are preset at 0.0 decibel (dB). Use this fader to emphasize or de-
emphasize a particular track. A track’s volume range is -inf. to 12 dB. Drag the slider left and 
right to adjust the volume.

Note: You may also move the fader by 
clicking it and using the right or left arrow keys 
on the keyboard. Press and hold the Ctrl key 
while dragging for finer control.

Pan slider

VideoFactory audio tracks are preset to center the signal. 
Move the slider to adjust the signal’s output left or right. As 
you move the slider, VideoFactory displays the signal’s 
percentage going to either the left or right channel. For 
example, moving the slider to 60%L means that sixty percent 
of the signal is mixed to the left channel, while forty percent 
is mixed to the right.

Scribble Strip

Double-click and type name

Double-click the slider
to reset to 0.0dB.
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Playback and preview

VideoFactory allows you to play back your project in two ways: directly within VideoFactory, 
or by mixing the entire project to a preview file.

Playback from within VideoFactory

VideoFactory has a Transport bar that allows you to play back your entire project or portions 
of your project based on a either a time selection or the current cursor position.

If your project includes video, make sure the Video Preview window is displayed for 
playback: from the View menu, choose Video Preview or press the  keys.

To play back an entire project:

1. Click the Play From Start button ( ) to begin playback at the beginning of the project.

2. Click the Stop button ( ) to stop playback.

Most of the time, you will only want to preview a small portion of the project to perfect a 
section. This can be done by creating a time selection.

To play back a time selection:

1. Place the mouse pointer above the ruler (on the Marker bar). 
The mouse pointer changes to include a left/right arrow cursor.

2. Drag to select the time region. To increase or decrease the time 
selection, click and drag its start and end points. The time 
selection bar appears above the ruler on the timeline.

3. Click the Play button ( ) to begin playback. Only the non-
muted tracks and events within the time selection will play back.

4. Click the Loop button ( ) to toggle VideoFactory to continually play back the events 
within the time selection. Click it again to toggle this feature off.

5. Click the Stop button ( ) to stop playback.

Loop Play from

Pause

Stop

Cursor 

Cursor 

Skip cursor

Skip cursor 

Play from 

play

start to start backward 

forwardto endcursor pos.

Alt + 6

Loop bar
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By looping the playback, you can repeatedly watch the same section of the project over and 
over as you make changes to effects in real-time. Selection areas can be quickly defined 
automatically, depending on what you would like to preview:

• Double-click any event to set the preview range to the duration of that event. This is 
useful if you are modifying an event with some kind of effect or transition and you want to 
check the results.

• Press + + +  or + + +  to create a selection area from the 
current cursor position to the next event edge.

Playback reference

The following table describes all the playback buttons and keyboard equivalents. You may 
use these playback functions at any time while working in your project.

Scrubbing

Scrubbing is a type of timeline playback that gives you 
precise control over the speed and direction of playback. 
There are two simple methods of doing this. First, the Scrub 
Control slider can be dragged back and forth. The further 
from the center that the handle is dragged, the faster the playback, both forward and in 
reverse. Below the slider is a small yellow marker that can be used to set the Normal Rate 
playback speed. This is the speed that the project plays at when the Play button on the 
Transport bar is clicked.

Button Keyboard Function
Turn on/off loop play during time selection playback

 + Begin playback from the start of the project

Begin playback from cursor position

Pause playback, cursor stops and holds at pause position

 or Stop playback, cursor stops and returns to prior cursor position

 + Place cursor at the beginning of project

 + Place cursor at the end of the project

Moves the cursor to the left in grid increments (if grid is displayed)

Move the cursor to the right in grid increments

Ctrl Alt Shift Ctrl Alt Shift

L

Shift Space

Space

Enter

Space Esc

Ctrl Home

Ctrl End

Page Up

Page Down

Scrub Control slider
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The second way to scrub is by positioning the mouse 
pointer over the timeline cursor at a location that is 
not over any events and holding down the  key 
on your keyboard. The cursor changes to a speaker 
icon. Now, when you left-click, the cursor icon 
changes again to a pan/scrub icon. When the mouse 
is dragged left or right, the timeline is scrubbed.

Press Ctrl over
timeline cursor

Left-click and 
drag to scrub

Ctrl
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Basic Editing 
Techniques
VideoFactory projects are multitrack compilations of events that occur over time. The 
events in your project are references (pointers) to source media files on your hard drive or 
other storage device. VideoFactory is a nondestructive editor, so altering events in your 
project will not affect the source media files in any way. As a result, editing events in 
VideoFactory is as simple as trimming event edges, arranging events, and mixing the events 
along the timeline.

Getting around

When editing and playing back the project, the cursor identifies where you are along the 
project’s timeline. The cursor can also be used to control the placement of events in the 
project.

By clicking and dragging you may select a time range in which you can perform edits, record 
into, and play back. For more information, see Selecting a time range on page 38.

The cursor may be controlled by the mouse or keyboard commands.

Description Keys Description Keys
Go to beginning of selection 
or view (if no selection)

Home or W Center in view \

Go to end of selection or view 
(if no selection)

End or E Jump to opposite side of 
selection

Num. pad 5

Go to beginning of project Ctrl+Home Move left to marker(s) Ctrl+Left Arrow

Go to end of project Ctrl+End Move right to marker(s) Ctrl+Right Arrow

Move left by grid marks Page Up Move left to event edit 
points including fade edges

Ctrl+Alt+Left Arrow

Move right by grid marks Page Down Move right to event edit 
points including fade edges

Ctrl+Alt+Right

Go to Ctrl+G Move one frame Alt+Left or Right 
Arrow
BASIC EDITING TECHNIQUES
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Jumping the cursor

The cursor can be rapidly jumped to various locations 
instantly.  and  jump to the left and right 
edge of the screen, while +  and +  
jump to the beginning and end of a project. 

+ +  or + +  moves to the previous 
or next event edge in the active track. Event edges are 
the start or finish of an event, including fades and 
transition boundaries. A single video event may 
therefore have a number of jump points including the 
start, the end of the transition into the event, the 
beginning of the transition out of the event, and the 
actual end of the event.

Frame-by-frame movement

The cursor can also be moved frame by frame (video frame) through a project or media file.

• Press +  or +  to move one frame at a time back and forth through a project on 
the timeline. One frame is defined by the project’s frame rate, configured by clicking the 
File menu and choosing Properties and then going to the Video tab.

• Press +  or +  to move one frame at a time back and forth through a media file 
that is opened in the Trimmer. One frame is defined by the media’s frame rate.

The cursor can also be moved in the same way by pressing + +  and using the 
mouse scroll wheel.

Focus

Focus is used to describe which objects have the attention of a program. The title bars of 
windows that do not have focus are gray, while windows that have the focus are colored 
(often blue by default). In VideoFactory, the focus determines the behavior of many 
commands and functions. For example, when you double-click a media file in the Explorer, 
it can be inserted into the track that has the focus. To instantly switch the program’s focus to 
the Track View (timeline), press +  or, from the View menu, choose Focus to Track View.

Making selections

VideoFactory gives you the flexibility to select one or more events, a time range, or events 
and a time range. All selection options can apply to a single track or to multiple tracks.

Markers

Grid
Time Selection

Grid

Home End

Ctrl Home Ctrl End

Ctrl Alt Ctrl Alt

Alt Alt

Alt Alt

Ctrl Shift Alt

Alt 0
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To select an event, simply 
point and click on it.

Selecting multiple events

By using the  key, the  
key, or the Selection Edit tool 
( ), you may select 
individual or multiple events 
in your project. Multiple 
events may be selected within 
a track or across tracks. Once 
events are selected, you may 
apply any of the Edit menu 
commands, switches or editing 
shortcut keys to them collectively.

Note: Media-specific (audio or video) effects 
and switches can only be applied to multiple 
events of the same type (e.g. Normalize can 
only be applied to audio events).

Whichever method you choose, you may include or exclude events from a selection area by 
holding down the  key and clicking on an event. The most common mode of operation 
is to select events by clicking on them while in Normal Edit mode. While this is the default 
editing mode, click the Normal Edit tool button ( ) or, from the Edit menu, choose 
Editing Tools and the choose Normal to switch back to this mode.

To select nonadjacent events:

1. Hold the  key.

2. Select the events by clicking on them. To deselect an event, simply click it again to toggle 
the event selection on or off. 

To select a range of events:

1. Hold the  key.

2. Click the first event that you want to select. 

3. Click the last event that you want to select. All events between the first and last selected 
events are highlighted and selected.

Selected events

Selected events

Ctrl Shift

Ctrl

Ctrl

Shift
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To select a block of events:

1. On the Toolbar, click the Selection Edit 
Tool ( ).

2. Position the cursor in a corner of the area 
that you want to select.

3. Click and hold the left mouse button.

4. Drag the cursor to the opposite corner of 
the area you want to select. A rectangle is 
drawn on the workspace. All events within 
this rectangle will be selected.

To deselect individual events in the middle of a selection area, hold the  key while 
clicking on the events. To deselect all of the events, click anywhere in the workspace 
outside of the selected events. 

Hold down the left mouse button and right-click to toggle through the three types of 
selection boxes: Free, Vertical or Horizontal.

Once events have been selected, they can be grouped together.

Selecting a time range

VideoFactory has a time selection bar that is located above the ruler. This bar displays, with 
a shaded box, the time range that you have selected. You may use the time selection bar for 
playing back a smaller portion of your project or to apply cross-track edits.

Unless an event is locked, a selected time range affects all events, or portions of events, that 
occur within the range.

To select a time range:

Ctrl

Loop bar

Only the events within 
the time selection will be
affected by edits or be
played back.
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1. Position the mouse pointer above the ruler (on the Marker bar). The mouse pointer 
changes to a left/right arrow cursor. 

2. Click and drag to select a region. All events, or portions of events within the region are 
highlighted.

3. Click and drag the yellow handles on either end of the time selection to increase or 
decrease your time range selection.

Note: You may move the entire selection 
range by dragging the Time selection bar.

Selecting a time range does not automatically select events. All items within the time range 
will play back and be affected by Edit menu commands.

Grouping events

VideoFactory allows you to group events together within tracks or across separate tracks. 
Once a group is created, all the events within it may be moved together as a unit and have 
event-specific edits applied at the same time. You may still edit properties of individual 
events within a group without affecting the other group events. Grouping is useful when you 
want to preserve timing of events and move them together along the timeline. 

To create a new group:

1. Select the events you want to group. Press the  key, the  key, or the Selection 
Edit tool ( ) to select them. For more information, see Selecting multiple events on page 37.

2. After the events are selected, you may group them in one of three ways:

• From the Edit menu, choose Group to display a submenu and then choose Create New.
• On one of the selected events, right-click to display a shortcut menu. From the shortcut 

menu choose Group and then, from the submenu, Create New.
• Press  to create the group.

To add a new event to an existing group:

1. Select an event in the existing group.

2. Right-click the event and choose Group | Select All to select all of the members of the 
group.

3. Press the  key and click on the event to be added to the group.

4. Right-click the event and select Group | Create New.

Ctrl Shift

G

Ctrl
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Note: Events can only be in one group at a 
time. Adding an event to an existing group 
essentially deletes the old group and creates a 
new one that includes all of the selected events.

Removing events from a group

Individual events may be removed from a group without affecting the other members of the 
group. The event you are removing from the group is not deleted from the project, but 
remains at its timeline position.

To remove an event from the group:

1. On the event you want to remove from the group, right-click to display a shortcut menu.

2. From the shortcut menu, choose Group and then choose Remove From on the submenu. 
The event will be removed from the group. The rest of the grouped events remain intact.

Selecting all members of a group

While grouped events move together, selecting one member of a group does not 
automatically select every member of that group.

To select all members of a group:

1. Right-click one of the members of the group.

2. From the shortcut menu choose Group and, from the submenu, choose Select All or press 
+  shortcut keys.

Temporarily disabling grouping

The grouping behavior of all groups (including video media files with included audio 
streams) in VideoFactory can be temporarily disabled by clicking the Ignore Event 
Grouping ( ) button.

Basic event editing

VideoFactory allows you to perform simple event-level editing. This editing includes 
common copying, pasting, and deleting operations. However, these editing procedures and 
how they are implemented depend on what type of selection is made: event only, time only 
or event and time selections.

Shift G
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Copying events

VideoFactory allows you to copy events, or portions of events, to the Clipboard and paste 
them into your project. You may copy a single event or multiple events. Copying preserves 
the original event information, edits, and other modifications.

To copy events:

1.  Click on the events to select them. For more information, see Selecting multiple events on 
page 37.

2. Select your time range, if applicable.

3. Copy the event to the Clipboard by doing one of the following:

• Press the  keys.
• Click the Copy button ( ) on the Toolbar. 
• From the Edit menu, choose Copy.

Copy time selection

Events within the time selection and across all tracks are reproduced and placed on the 
Clipboard. Time information is also placed on the Clipboard. You can make a time selection 
first and then select events within that time selection to further modify a selection.

Cutting events

Cutting events removes them from their respective tracks, but places the cut information 
(events and time) on the Clipboard. Once on the Clipboard, you may paste the information 
into your project.

To cut an event:

1. Click on the event to be cut to select it or select a time range.

2. Cut the event to the Clipboard by doing one of the following:

• Press the  keys.
• Click the Cut button ( ) on the Toolbar. 
• From the Edit menu, choose Cut.

Events before copy Clipboard contents Events after copy
The original events are not 
affected and do not 
change.

Ctrl + C

Ctrl + X
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Pasting events

Once information is copied to the Clipboard, you may choose a variety of ways to paste the 
Clipboard items. VideoFactory always pastes from the insertion point’s position along the 
timeline.

To paste events from the Clipboard:

1. Move the cursor to the desired timeline location.

2. Click either the track number or within the track where you want to paste the event. 
This track is the focus track; there can be only one focus track at a time.

3. Paste the event into the track by doing one of the following:

• Press the  keys.
• Click the Paste button ( ) on the Toolbar.
• From the Edit menu, choose Paste.

Clipboard events are pasted at the cursor position on the track. 
Existing track events can be overlapped with newly pasted 
information.

Paste Insert and Ripple editing are more advanced methods of pasting events in 
VideoFactory. For more information, see Ripple editing across all tracks (Paste Insert) on page 50.

Duplicating events

Duplicating is a combination of a copy and paste in one action.

To duplicate an event:

1. Hold the  key on your keyboard.

2. Drag the event you want to duplicate to the place where you want the new event to be 
positioned.

Ctrl + V

Before pasting:

After pasting:

Ctrl
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The process is like moving the event to a new position while leaving a copy behind. This 
technique is a great way to copy the attributes of an event (e.g. effects, stretching, 
envelopes) and apply them to a new media file.

To copy attributes to a new video event:

1. Duplicate the event with the desired attributes (switches, envelopes, effects, etc.).

2. Using VideoFactory Explorer, locate the video file that you want to copy the attributes to.

3. Right-click the file and drag it to the duplicated (new) event.

4. From the shortcut menu, choose Add as Takes.

5. The new media file becomes the Active take. You can delete the original take.

Basically, what you are doing is duplicating an event and then replacing the contents with 
new video. For more information, see Takes on page 55. If you only want to apply a specific 
effect with particular settings to another event, save the settings to a preset for future use. 
For more information, see Modifying FX on page 102.

Trimming events

To edge trim a video event:

1. Insert an event into the Timeline.

2. Move the cursor over the edge of the event.
The cursor changes when properly positioned.

3. Drag the edge of the event to trim.

During the trimming process, the last thumbnail image on the 
event shows the last frame in the event, allowing you to edit 
events very accurately. Events cannot be trimmed back from their 
starting point towards an earlier position on the timeline unless 
the beginning has been previously trimmed. However, you can 
extend a video event beyond its end, in the process making it 
longer. When you do this, the event is looped or repeated. A 
notch appears at the point in the event where the video ends and 
the thumbnails begin repeating. Since a multimedia file often has both a video and an audio 
component, both events are trimmed as a group (unless you ungroup them).

Trimming events removes all media outside the time selection from their respective tracks. 
However, the removed information is not placed on the Clipboard. Trimming is different 
from cutting in that the events within the time selection are preserved.

To trim an event based on a time selection:

1. Select a time range.
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2. Press the  key or, from the Edit menu, choose Trim.

Events outside the time selection are removed from the project. However, the time 
information (space) between events is not removed.

Another method of trimming media files is to use VideoFactory’ Trimmer. For more 
information, see Trimmer window on page 57.

Splitting events

VideoFactory allows you to create multiple, independently functioning events from a single 
event by splitting it. Splitting creates a new ending point for the original event and creates a 
starting point for the newly created event. Splitting an event does not alter the original 
media. The original media file’s information is there, but omitted for playback based on 
where the event’s starting or ending point occurs on the timeline.

To split an event: 

1. Select the event to be split.

2. Place the cursor at the timeline position where the split 
will occur.

3. Split the event(s) by doing one of the following:

• Press the  key.
• From the Edit menu, choose Split.

To split multiple events, use the  key, the  key, or the Selection Edit Tool ( ) to 
select the events. For more information, see Selecting multiple events on page 37.

Shifting the contents of an event

Events in VideoFactory are defined by their duration and not by the actual content. 
Typically, an event contains a portion of a larger source media file saved somewhere on your 
computer. For example, you could have an event that contains only the ten seconds (e.g. 
from 00:40 to 00:50) of a one minute long video file. The actual footage it contains can be 

Events before trim Clipboard contents Events after trim
Trimmed information is not 
placed on the Clipboard.

Ctrl + T

Original event

Split position

Two events

Separated events

S

Ctrl Shift
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modified in a number of ways, including shifting it to encompass, for example, from 00:20 to 
00:30 in the original video file. To shift the contents of an event Hold the  key while 
dragging left or right on a video event.

Deleting events

Deleting events removes all events within the time selection from their respective tracks. 
However, the removed information is not placed on the Clipboard.

To delete an event:

1. Click on the event to be deleted to select it or select a time range.

2. Delete the event(s) by doing one of the following:

• Press the  key.
• From the Edit menu, choose Delete.

Alt

The original media file.

The event trimmed from
the original media file.

The event on the timeline.

The event with new (shifted) contents.

Delete
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Delete time selection

Events within the time selection are removed from the project. However, the time 
information (space) between events is not removed. This space would be removed if Ripple 
Editing mode was active.

Crossfading events

VideoFactory allows you to 
crossfade between two events 
(audio and video) on the same 
track. Crossfading gives you the 
ability to fade out one audio 
event’s volume while another 
event’s volume is fading in on or to transition between two video events, one fading out 
while the other fades in. Lines appear indicating how and when the event’s volume or 
transparency is being affected.

Automatic crossfades

The Automatic Crossfade feature turns the overlapping portions of two events (audio or 
video) into a smooth crossfade. Click the Automatic Crossfade button ( ) or press the  
shortcut key to enable or disable Automatic Crossfades.

The crossfade “x” will automatically adjust itself as you move one event over another as long 
as one event’s edge is crossing the other event’s edge. In the case where edges do not cross 
(one event is wholly contained in another), the shorter event will be placed on top of the 

Events before delete Clipboard contents Events after delete
Deleted information is not 
placed on the Clipboard.

Fade in
volume line

Fade out
volume line

X

Events before crossfade Events after crossfade

Drag the event to
overlap the other
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longer event. Automatic crossfade can be toggled on and off: from the Tools menu, choose 
Automatic Crossfade. You may still set a crossfade in this situation. Use the event’s handles to 
adjust the desired crossfade between the two events.

Manually setting a crossfade

The duration of a crossfade can be adjusted by simply dragging the edges of the two 
overlapping events involved in the fade. Place the mouse pointer on one of the events’ 
edges. When you see the envelope cursor appear, click and drag the handle to the desired 
position.

Changing crossfade curves

You can set the crossfade curve(s) 
that VideoFactory uses to fade in and 
out between two events. The 
crossfade curves determine how 
VideoFactory raises and lowers the 
events’ volumes over time.

To change the crossfade curve:

1. Right-click anywhere in the 
crossfade region to display a 
shortcut menu. 

2. From the shortcut menu, choose 
Fade type to display the fade types submenu.

3. Click the desired fade type to set it.

Undo and Redo commands

VideoFactory gives you unlimited undo and redo functionality while working on your 
project, even to the extent of being able to undo changes made before the last time a project 
was saved (but not closed). While you are working with a project, VideoFactory creates an 
undo history of the changes that you have performed. Each time you undo something, that 
change is placed in the redo history. When you close the project or exit VideoFactory, both 
the undo and redo histories are cleared. 

Right-click in crossfade region

Fast in - Slow out

Linear in - Linear out

Slow in - Fast out

Fast in - Fast out

Slow in - Slow out

Linear in - Fast out

Linear in - Slow out

Fast in - Linear out

Slow in - Linear out
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Undo command

Pressing the  keys or Undo button ( ) on the Toolbar will undo the last edit 
performed. Repeatedly using the keyboard command or Toolbar button will continue 
undoing edits in reverse order, from most recent to oldest.

Undoing a series of edits

Click the arrow to the right of the Undo button ( ) on the Toolbar to view a history of 
your edits. A drop-down list appears. The top listed item is the most recent edit. If you want 
to undo a specific edit that appears farther down the list, all subsequent edits will also be 
undone as well. 

To undo a series of edits:

1. Click on the arrow to the right of the Undo button ( ).

2. From the drop-down list, choose the edit that you want to undo. Items above it 
(subsequent edits) will be selected automatically. Click outside the drop-down list to 
cancel undo.

3. Click the item to undo it and all selected edits. VideoFactory will restore your project to 
the state prior to those edits.

Note: From the Edit menu choose Undo All 
to undo all edits in the history. All edits will be 
undone and added to the redo history.

Redo command

Pressing the  keys or the Redo button ( ) on the Toolbar will redo the last 
undo performed. Repeatedly using the keyboard command or Toolbar button will continue 
redoing in reverse order, from most recent to oldest. In addition, you may redo the last edit 
by choosing it by name from the Edit menu.

Clearing the edit history

You may clear both undo and redo histories without closing your project or exiting 
VideoFactory.

To clear the edit histories:

1. From the Edit menu, choose Clear Edit History. A confirmation dialog will appear.

2. Click Yes to clear the edit histories. Or, click No to cancel and keep the edit histories.

Ctrl + Z

Ctrl + Shift + Z
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Advanced 
Editing 
Techniques
This chapter builds on the techniques that were introduced in the last chapter. Ripple 
editing, pitch shifting, and takes are just three of the more advanced editing topics that are 
covered in this chapter. Later chapters are broken down by specific subject and go into even 
greater detail.

Ripple editing

Ripple editing is a timeline-based procedure that allows you to cut, delete, and paste events 
or portions of events within a time selection and simultaneously re-adjust existing events on 
the timeline. For example, existing events are automatically moved out of the way (down 
the timeline) to make room for a newly inserted event.

Ripple Edit mode is activated by clicking the Ripple Edits button ( ) on the Toolbar or 
pressing the  shortcut keys.

Ripple editing from the Trimmer

It is possible to insert a clip into the original, dividing it into two parts and moving the 
second part down the timeline. When the inserted event ends, the original resumes playing 
at the cut point (this is sometimes referred to as a “film-style insert”). Ripple editing applies 
only to the selected track. If the selected track is a video track with an associated audio 
track, the audio remains locked to the video and is also rippled. Ripple editing also works 
with Paste operations.

Ctrl + L

Before ripple:

After ripple:

Inserted event Rippled event
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To perform a ripple edit:

1. Position the cursor at the insertion point for the new event.

2. Make sure ripple editing is turned on. Click the Ripple Edits button ( ) or, from the 
Options menu, choose Ripple Edits [CTRL+L] to toggle ripple editing on and off.

3. Open the media file you want to insert in the Trimmer. For more information, see Trimmer 
window on page 57.

4. Create a selection area in the Trimmer of the section of the media files that you want to 
use.

5. Click the Add media from cursor button ( ).

Cutting and deleting in ripple mode

When Ripple mode is turned on, cutting and deletion operations on a time selection area 
ripples all events further down in a project, moving everything left.

To cut/delete time:

1. Click the Ripple Edits button ( ) on the Toolbar to toggle it on.

2. Create a time selection.

3. Cut the event to the Clipboard by doing one of the following:

• Press the  keys to cut or .
• Click the Cut button ( ) on the Toolbar. 
• From the Edit menu, choose Cut or Delete.

The exact behavior of the ripple depends on any event selections 
within the time selection area. If one or more events are selected, only those tracks with 
selected events are ripples.

So if you wanted to remove an event and ripple everything downstream in only one track, 
double-click the event (which selects it and automatically creates a time selection area) and 
then press . To ripple every track in the project when a single event is removed, 
double-click the event (which selects it and automatically creates a time selection area), 
then press the  key and click the same event again (this selects all events within the time 
selection area), and then press .

Ripple editing across all tracks (Paste Insert)

Ripple editing can also be applied across tracks.

To ripple edit across all tracks:

Ctrl + X Delete

Delete

Ctrl 

Delete
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1. Copy an event to the Clipboard (from the timeline or Trimmer).

2. Move the cursor to the desired timeline location.

3. Click either the track number or within the track where you want to paste the event. 

4. Paste insert the event into the track by doing one of the following:

• Press the  keys.
• From the Edit menu, choose Paste Insert.

Clipboard information is pasted at the cursor’s position on the selected track. Existing track 
events or portions of events after the cursor are adjusted to occur later in the project (moved 
right). The amount of adjustment is based on the total length of the information being 
pasted.

Ctrl + Shift + V

Video event to be 
Paste Inserted here on
second video track

All events on all tracks
after the inserted event
are shifted to the right
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Project markers and regions

VideoFactory allows you to use three types of project markers that identify parts of your 
project, serve as cues, and provide additional functionality for certain file formats. The three 
types of markers are:

• Markers–points that you place along the project’s timeline. They are typically used to 
mark interesting parts in the project for later reference or to mark timing cues.

• Regions–ranges of time. Typically, regions identify ranges of time that you need to get 
back to later. Regions can function as permanent time selections.

• Command markers–are used to enable metadata in streaming media files. These markers 
can be used to display headlines, captions, link to Web sites, or any other function you 
define.

Markers and regions can also be added to, and saved along with, media files. For more 
information, see Adding regions and markers to a media file on page 59.

Working with markers

Markers are useful for identifying and navigating to specific points in longer projects. As you 
place markers in your project, VideoFactory automatically numbers them in the order that 
they were placed. You may name them and reposition them along the project’s timeline. 

Placing and moving a marker

Markers are placed at the cursor’s position via the 
Insert menu, by right-clicking on the Marker bar, 
or by pressing the  key. You may place a marker 
by positioning the cursor or on-the-fly while your 
project is playing back. Markers appear as red tags 
above the ruler and are automatically named.

Markers can be repositioned or moved by dragging 
them left or right on the Marker bar.

To name (rename) a marker:

1. Right-click the marker to display a shortcut menu.

2. From the shortcut menu, choose Rename. A text box opens next to the marker.

3. Enter a marker name.

You can also double-click an existing name or double-click the space just to the right of a 
marker to rename it.

Marker

Marker bar

M
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Navigating to a marker

The cursor position can be instantly jumped to any marker on the timeline by simply 
clicking on the marker. You can also jump to a marker by pressing the number keys along the 
top of the keyboard (not the number pad numbers).

Note: The cursor can be jumped to the next 
or previous marker by pressing the +  or 

 keys.

Deleting a marker

Right-click on a marker and, from the shortcut menu, choose Delete. The marker will be 
removed from your project. VideoFactory will not renumber the tags as you remove them. 
For example, if you have five markers in your project and delete markers 3 and 4, the 
remaining markers will be listed as 1, 2 and 5. However, as you add markers again, 
VideoFactory will begin numbering the missing sequence first, in this case 3 and 4, then to 6, 
7, 8, etc.

To delete all markers and regions:

1. Right-click on the Marker bar.

2. From the shortcut menu, choose Markers/Regions.

3. From the submenu, choose Delete All.

Working with regions

Typically, regions identify ranges of time that you need to get back to later. Regions can 
function as semi-permanent time selections.

Placing and adjusting a region

Region markers may be placed at 
the cursor position and at the 
beginning and end points of a 
time selection via the Insert 
menu or pressing the  key.

Individual Region Markers can 
be repositioned independently 
by dragging the marker left or right on the Marker bar. To delete a region from your project, 
right-click one of the region markers and, from the shortcut menu, choose Delete.

Ctrl

Region start

Marker bar

Region end

R
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Naming a region marker

Regions can be named by right-clicking the left marker in a region and selecting Rename 
from the context menu.

Selecting a region

You may select the events, across all tracks, within the region for editing or playing back. 
Right-click on one of the region markers to display a shortcut menu and, from the shortcut 
menu, choose Select Region.

Time compressing/stretching

Time stretching and compressing 
events is a method of making an 
event longer or shorter. When audio 
is compressed or stretched, the pitch 
is also altered. When video is 
compressed or stretched, the speed of 
the action is sped up or slowed down.

To time compress/stretch an event:

1. Hold the  key on your 
keyboard.

2. Drag the edge of the event towards the center of the event to compress (shorten) it or 
drag the edge out away from the center to stretch (lengthen) it.

Time compressing/stretching video

Time stretching video allows you to fill a given duration with a set amount of actual video, 
sometimes called fit-to-fill. For example, if you have a five-second video event and you want 
this event to fill an eight-second slot, hold the  key and drag the edge of the event to 

Original event

Compressed events have a
higher pitch and are sped up

Stretched events have a lower
pitch and are slowed down

Ctrl

Ctrl
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eight seconds. The resulting video will be in slow motion, but the contents (footage) would 
remain the same. Stretched video has a zigzag line between thumbnails. Video can also be 
compressed (sped up and shortened in length) by using this method.

Stretching or slowing video events may result in jumpy or stuttering video output. This 
problem may be resolved by resampling the source media, which allows VideoFactory to 
interpolate some of the video. This process results in a slower render, but may improve the 
quality of the video.

To resample an event:

1. Right-click the event and choose Properties.

2. On the Video Event tab, select Resample.

Takes

A take is a version of a scene, as in “Scene 10, Take 7”, which means the seventh time that 
scene number ten has been shot. VideoFactory has the ability to allow you to include a 
number of takes in the same location (event) of the project. You can then rapidly switch 
between these separate takes to see which one fits into the project the best. Although this is 
what takes are designed for, you can actually use any clips you want as a take, even 
completely different shots or scenes. Since an event is just a container of a specific length 
and at a specific location, the actual contents (media file) are easily changed.

Adding takes

Multiple media files can be added to the timeline at the same time to a single event as takes.

To insert multiple media files to the timeline as takes:
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1. Locate the media files that you want to insert as takes in VideoFactory Explorer and select 
them. Select a range by holding  and clicking, or select nonadjacent files by holding 

 and clicking the various clips individually.

2. Right-click and drag one of the selected clips in the group to the timeline or to a video 
track.

3. From the shortcut menu, choose Add As Takes (or Video Only: Add As Takes to insert only 
the video and not the audio portion of the clips).

Media files can also be added to existing events as takes.

To add a take to an existing event:

1. Right-click a media file in the Media Explorer and drag it to an existing event. 

2. From the shortcut menu, choose Add as Takes.

Selecting takes

When you add an event with multiple takes, a single event is inserted into a video track. 
The last clip that was selected determines the duration of the event and is set as the active 
take.

To select a take (and make it the active take):

1. Right-click an event with multiple takes. 

2. From the shortcut menu, select Take.

From the submenu, choose Next Take, Previous Take or choose a named take from the list. 
Press the  key to select the next take or +  to select the previous take.

Longer takes can be positioned within a shorter event by holding the  key while 
dragging on the take in the event. You will notice that the thumbnails representing the take 
will change while the event itself remains unmoved.

Adding takes to an event is an excellent method of 
maintaining consistency between a number of events in 
a project that may use a complex set of effects. First, 
duplicate an event by holding the  key while 
dragging an event. Then, replace the contents of the 
event by adding a take.

To display take names on events:

1. From the Options menu, choose Preferences.

2. Select the Show active take names in events check box to enable it.

Shift

Ctrl

T Shift T
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Before preference
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After preference
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Deleting takes

Individual takes can be deleted from an event at any time.

To delete a take:

1. Right-click an event with multiple takes. 

2. From the shortcut menu, go to the Take menu item.

3. Choose Delete Active to immediately remove the active take or choose Delete to open a 
dialog with a list of all of the takes contained in this event.

Trimmer window

The Trimmer allows you to work with and edit one media file at a time.

To open a clip in the Trimmer:

1. Click on a clip on the timeline to select it.

2. Right-click on the clip and choose Open in Trimmer.

Events can also be opened in the Trimmer by dragging them from the Explorer or the Media 
Pool.

Note: If the event in your project is only using 
a portion of a larger media file, the Trimmer 
will select the portion being used.

Trimmer list

Media file

Playback

Loop

Add mediaCursor

Marker

Open in

Clear Trimmer

Save Markers/Region

Remove From 

Region Sort Trimmer

Loop region or
Selection area

to cursor

Add media
from cursor

navigation

History

History Trimmer list

Audio Editor

controls

Portion being used
in the project

Entire media file
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To set the Trimmer as the default destination for a clip when it is double-clicked:

1. From the Options menu, choose Preferences.

2. Click the General tab.

3. Choose Double-click on media file loads into Trimmer instead of tracks.

Like many other windows in VideoFactory, the Trimmer 
window can be docked to the bottom of the workspace or 
you can drag it to freely float it anywhere on the screen. You 
can open any number of clips in the Trimmer at the same 
time, selecting the one you currently want to work on from 
the drop-down list.

From the View menu, choose Trimmer or press the  shortcut keys to display the 
Trimmer window, if it is not displaying already.

Working with the Trimmer window

As you navigate (move the cursor) around in the Trimmer, the exact frame that the cursor is 
over in time is displayed as in a thumbnail image under the cursor. When using the left and 
right arrow keys, this allows you to create edit point with frame accuracy. Make sure Animate 
video frames in Trimmer is selected in the Preferences dialog to use this feature. 

To set mark in and out points:

1. Open a clip in the Trimmer.

2. Click the Play From Start button ( ).

History drop-down This drop-down list displays all the events in your current project. You may 
open a media file in the Trimmer by selecting its filename from the list.

Marker bar This area displays the markers that you place along the media file’s timeline. 
The marker bar is identical to the one in the timeline.

Save button ( ) If you have added markers or regions to a media file in the Trimmer, you can 
save that data to the referenced media file for use in the sound editor or in later 
projects.

Selection bar The selection bar is identical to the one found in the timeline. Use it to select 
portions of audio that you would like to place on a track or for setting regions 
(pg. 38).

Selection tab Click this tab to bring the Trimmer to the front when it is “behind” other 
docked windows.

Sound editor button ( ) This button opens the event in your sound editor application (pg. 48). 

Transport bar The Transport bar is identical to the one found in the timeline (pg. 14).
Ruler The ruler is identical in functionality as the one in the timeline.
Zoom buttons These buttons are identical to the ones in the timeline. 

Alt + 2
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3. When you get to the place where you want the edit to start (Mark In), press the  key 
or the  key.

4. When you get to the place where you want the clip to end (Mark Out), press the  
key or the  key.

Once your clip has been trimmed in the Trimmer, you can insert it into your project in a 
couple of ways.

• Drag-and-drop it to the timeline. 
• Click the Add Media From Cursor (A) button to insert the event after the 

cursor or click the Add Media Up To Cursor (SHIFT+A) button to insert the 
event before the cursor.

Adding regions and markers to a media file

The Trimmer allows you to add markers and regions to a media file the same way you add 
them to your project. However, these markers and regions are different from project markers 
and regions, which was described earlier in this manual. The difference between the two is 
simply that project markers and regions affect the project, while media file markers and 
regions are embedded in the media file.

When you add a marker or region to a media file, VideoFactory does not add the markers to 
the project. Markers and regions that are added from within the Trimmer are only 
temporary. You must save them if you want to use them again after you close the project. 
After the markers and regions are added and saved to the media file, they will be available 
when you open the media file in a sound editor program or in the VideoFactory Trimmer. 
Markers are placed at the cursor’s position. You may also place a marker on-the-fly while the 
media file is playing back. Markers appear as red tags above the ruler.

A region is placed at the cursor’s position or at either end of a time selection. You may also 
place a region on-the-fly while the media file is playing back. A region appears as green tags 
above the ruler. Region information can be displayed in the Explorer window.

To add markers or regions:

1. Position the cursor or make a time selection.

2. Place the marker or region in one of the following ways:

I

[

O

]

Marker Region
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• From the Insert menu, choose Marker or Region.
• Right-click on the Trimmer Marker bar and choose Marker or Region from the shortcut 

menu.
• Press the  (marker) or  (region) shortcut keys.

3. Click the Save button ( ) to save the markers and regions to the media file.

Markers and regions can be automatically saved to a media file by clicking the Options 
menu and choosing Preferences and selecting Automatically save Trimmer markers and regions 
with media file. Markers cannot be saved to media files with properties set to read-only in 
Windows.

Mixer window

The Mixer is a dockable window that can be used to adjust the preview and output volume 
of a project. The volume can be set using the Preview and Output faders. The Preview fader 
controls the volume of media files that are previewed from the Media Explorer (pg. 24) and 
the Output fader acts as the master volume control for the project.

Using the faders

The Preview and Output faders allow you to adjust the volume and monitor output levels of 
media files when you preview them from the Explorer window or play them back from the 
Trimmer window.

Changing meter resolution

You may select a preferred meter resolution at which the faders display the media file’s 
volume level. When you change the meter resolution on one fader, the other meter 
automatically change to match. Right-click on the meter to display a shortcut menu and, 
from the shortcut menu, choose the meter resolution you prefer.

Adjusting for clipping

At times, a project’s volume level may be too high and cause clipping. The clip is displayed 
on the fader’s meter. If signal clips, the meter will display in red at the top with the clipping 
value displayed in decibels (dB). Adjust the fader and click the red area with the clipping 
value to reset the meter. Continue to adjust the fader and reset the meter until clipping is 
eliminated.

M R
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Right-click on a fader’s meter and click Reset Clip to clear the red clipping indication. The 
fader’s meter can be set to remember and display the highest and lowest levels by right-
clicking and selecting Hold Peaks and Hold Valleys.

Accessing event properties

VideoFactory allows you to adjust individual event properties. When you set an event’s 
properties to be different from the original referenced media file, the original media is not 
affected. The event settings are only used in VideoFactory.

To view an event’s properties:

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog will appear.

The event properties settings that you may change are the active take’s name and any 
switches used.

Event switches

Event switches are functions that you can apply to events. You may apply switches to a 
single event or to multiple events at the same time. Switches allow you to edit specific track 
events by muting, locking, looping, normalizing the waveform of an audio event, or 
maintaining the aspect ratio of a video event.

You may access switches from the Edit menu by choosing Switches to display its submenu, 
right-click a selected event and choose Switches to display its shortcut menu, or open the 
Event Properties dialog and select the switches there.

Clipping signal 

Click the clipping 
indicator to reset 
the meter

Adjusted fader
with dB value and Reset meter

and set the meter to 

Right-click to reset clip,
change meter resolution,

hold peaks and valleys.
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To use an event switch:

1. Right-click on an event.

2. From the shortcut menu, choose Switch and then 
choose the specific switch from the submenu.

Switches can also be applied by selecting an event and, 
from the Edit menu, selecting Switch to display the 
submenu, and then choosing the specific switch. Active 
switches have a check mark next to them. Click an 
active switch on the menu again to turn it off. 

The following list summarizes the various event switches:

• Lock prevents the event from being moved on the timeline.
• Loop allows you to extend the event along the timeline (in a loop) by dragging the right 

edge of the event. VideoFactory loops the entire media file, not just the displayed portion.
• Maintain Aspect (video only) keeps a video event’s relative dimensions constant (e.g. 4:3).
• Mute prevents the event from playing back.
• Normalize (audio only) maximizes an audio event’s volume without clipping.

Locking an event

You may lock an event to prevent it from being moved or edited. Lock may be applied to one 
or more selected events. When you switch an event to lock, the Switch submenu displays a 
check mark indicating that Lock is enabled. The event will remain locked until you disable 
the switch. Multiple events can also be locked in this way. For more information, see Selecting 
multiple events on page 37.

Looping an event

You may loop an event so that you can extend it along the timeline by dragging the edges of 
the event. Loop may be applied to one or more selected events. When you switch an event 
to loop, the Switch submenu displays a check mark indicating that Loop is enabled. The 
event will remain looped until you disable the switch. Notches appear in the top of the 
event to mark where the media in the event ends and then repeats.

Selected event 
before lock

Selected event after
lock is applied
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Looping is slightly more complex for video events. When looping is off, the last frame will 
be repeated for the duration of the event beyond its original length, creating a freeze frame 
effect, as in the middle example. The event in the last example below is looped three times. 
Each repetition is noted by a notch in the event.

Maintain aspect ratio (video only)

Video and image files of various sizes and formats can be included in a single project. The 
project itself may have a different frame size aspect ratio from the source media files. This is 
not a problem, but you must specify how VideoFactory handles these differences. If the 
length-to-width ratio between the source media and the project’s frame size are the same 
(e.g. source media at 320x240 and project frame size of 640x480), no aspect ratio distortion 

Selected event 
before loop

Selected event after
loop is applied Drag the right edge

to extend the event

looping notches

The original three frame clip.

Looping is off. The elongated event repeats (freezes) the final frame.

Looping is on. The entire event repeats.

notch
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occurs. If the ratios are not the same, the source material may become distorted (stretched or 
squashed). By maintaining the aspect ratio of the original, VideoFactory will keep the video 
from becoming distorted by letter boxing around the edges. This is the default setting.

Muting an event

You may mute an event to prevent it 
from playing back. Mute may be applied 
to one or more selected events. When 
you switch an event to mute, the Switch 
submenu displays a check mark 
indicating that Mute is enabled. The 
event remains muted until you disable 
the switch.

Normalize (audio only)

You may normalize an event to 
maximize its volume, based on the 
waveform’s highest peak, without 
clipping the event during playback. 
Normalize may be applied to one or 
more selected events. When you switch 
an event to normalize, the Switch 
submenu displays a check mark indicating that Normalize is enabled. The event will remain 
normalized until you disable the switch.

The *.bmp media file in this
example is 320x100, while the
project is set to 320x240.

Selected event 
before mute

Selected event after
mute is applied

Selected event 
before normalize

Selected event after
normalize is applied
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Recalculating the normalization

When you normalize an event, VideoFactory analyzes the event and raises the volume based 
on the waveform’s highest peak and then adjusts the rest of the event accordingly. There 
may be times when you have adjusted the edge of an event to exclude the (formerly) highest 
waveform peak. In this case, you may want to recalculate the event’s normalization.

To recalculate the normalization:

1. Right-click the event to display a shortcut menu.

2. From the shortcut menu, choose Properties. The Event Properties dialog opens.

3. Click Re-calculate to normalize the event again.

Audio event envelopes (ASR)

You may apply envelopes to individual events. Envelopes, also known as ASRs (attack, 
sustain, and release), give you the ability to control an audio event’s volume. The fade-in, 
fade-out, and overall level of the event may be also controlled.

When you place an event into your project, VideoFactory adds handles that are used to set 
the envelope. As you use these handles on audio events, a volume line will appear indicating 
how the event is being affected. The waveform will graphically display the volume change.

Setting an audio event’s volume

When you place the mouse pointer at the top of the event, the pointer changes to a hand 
cursor that you may use to lower the event’s overall volume. Place the mouse pointer at the 
top of the event and, when you see the envelope cursor, drag the volume line to the desired 
level. As you drag the volume line down, VideoFactory displays the event’s attenuation.

Volume lineEnvelope
handles

Volume line

Decibel level
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Setting an event’s fade in and out

The event handles allow you to affect an audio event’s fade in and out volume and a video 
event’s opacity. The type of curve that the event uses to control the volume’s fade in or out 
can also be changed.

To set the event’s fade in or out:

1. Place the mouse pointer on a handle.

2. As you drag the cursor, the volume line appears. VideoFactory displays both the time in 
the event when the volume will be maximized and its decibel level. 

Changing the event’s fade curve

You can set the fade curve (fast, linear, or slow) that an event uses to raise or lower the 
volume over time.

There are two ways to access the fade curve types. You may right-click anywhere in the 
event’s fade-in or -out region to display a shortcut menu. From the shortcut menu, choose 
Fade type to display the Fade Types submenu. Click the desired fade type to set it. The 
second way is to go directly to the fade types shortcut menu. When the envelope cursor is 
displayed, right-click to display the shortcut menu. Click the desired fade type to set it.

Time and
decibel

Volume line

Fade in Fade out

Volume line

Time and
decibel

Fade in curves Fade out curves

Fast

Linear

Slow
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Audio track envelopes

Track envelopes allow you to control volume and panning aspects of a particular track. 
Volume envelopes automate the volume used for events on a track. A panning envelope 
automates the panning aspects used for events on a track.

To add a Volume or Pan envelope:

1. Select the track where you want to add the volume envelope. Multiple tracks may be 
selected.

2. From the Insert menu, choose Audio Envelopes and then choose Volume or press the  
key. A blue line appears across the track(s).

Adding envelope points

Once a volume envelope is placed, you may add points to it. These points will be used to 
move the envelope line so that volume changes will be smoothly automated. Double-click 
the envelope line to add an envelope point. A square point appears on the envelope line.

Note: Points may be deleted by right-clicking 
it and choosing Delete from the shortcut 
menu. All envelope points may be deleted by 
selecting Reset All from the shortcut menu.

Once the envelope points have been added, you may raise and lower them to different levels 
along the timeline to automate the track’s volume. You may move one point at a time, even 
during playback and listen to the results in real time.

Changing the fade curves

Between each envelope point, you may set the type of volume fade curve: fast, linear, or 
slow. From the selected envelope point, fade curves are applied to the volume line as it 
occurs later on the timeline. 

To set the volume fade curve:

1. Right-click on a point to display a shortcut menu.

V

Fast fade

Slow fade

Linear fade

As the example shows, you may have more
than one type of fade curve on an envelope.
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2. From the shortcut menu, choose the curve type. Curve types are applied to volume lines.

Hiding audio track envelopes

After you have set your volume envelopes on the tracks, you may hide them from the Track 
View. Hiding volume envelopes will not affect playback. The points that you set will still 
automate the volume, even though they will not be visible. From the View menu, choose 
Show Audio Envelopes. From the submenu that appears, clear the check next to the Volume 
menu item.

Removing audio track envelopes

When an envelope is removed, the events on the track will no longer have automated 
volume control. The volume envelope line will also no longer be displayed. From the Insert 
menu, choose Audio Envelopes. From the submenu that appears, clear the check next to the 
Volume menu item. It is important to remember that when you remove a volume envelope 
from a track and then add it again, all volume points will be reset.

Locking envelopes to events

Track envelopes extend for the length of a track and are independent of the events on the 
track. This means that the envelope remains in place when you move the events in the 
track. Carefully adjusted track envelopes can be set to move with the underlying events. To 
lock all of the envelopes in a project to the events they are contained in, click the Lock 

Envelopes to Events button ( ) on the toolbar or, from the Options menu, choose Lock 
Envelopes to Events. The lock can be toggled off by clicking the button again.
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Advanced Video 
While simple to learn, VideoFactory is a powerful application with many advanced features. 
This chapter covers the tips, tricks, and techniques that are needed to master the video 
features of this powerful tool.

Pan/Crop

The Pan/Crop tool can be used for cropping, zooming, rotating, panning, and scrolling. The 
dialog can be opened by clicking the Event FX button ( ) on an event and then clicking 
the Pan/Crop tab in the window that opens.

Cropping

Cropping is the process of removing the outside edges from an image or video, thereby re-
framing the subject. In the example below, the Pan/Crop dialog on the left has been used to 
create a selection area around the subject, removing extraneous information from the 
outside of the video. This creates a zoom effect that is identical to using a digital zoom on a 
camcorder. The Video Preview window on the right displays the final movie after cropping.

Crop Area

Preview
output

Event FX
button
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To crop a video event:

1. Click the Event FX button ( ) on the event and then clicking the Pan/Crop tab in the 
window that opens.

2. Drag the handles (small boxes) located around the perimeter of the selection area to 
change the size.

3. Click in the middle of the selection area and drag to reposition it.

The cropping occurs instantly and the results are updated in the Video Preview window. 
Cropping applies to the entire event and can be animated between the beginning and the 
ending.

To use this dialog to crop the frame, grab the crop Handles using the Move Tool ( ) to 
resize the crop selection area. When the cursor is positioned anywhere over the crop 
selection area you can drag it into position. To prevent distortion, it is a good idea to 
maintain the relative X and Y values of the crop area by clicking the Lock Aspect Ratio 
button ( ). Maintain aspect ratio, on the other hand, prevents the source media from 
becoming distorted. The Constrain Movement button is a three-state button: Move Freely 
( ), Move X Only ( ), and Move Y Only ( ). This is used to create straight scrolls or 
pans in a single direction.

To modify the effects on a different event, click the Event FX button ( ) on that event.

Move Tool [S]

Magnify Tool [M]

Toggle Snap [SHIFT]

Lock Aspect Ratio [CTRL]

Stretch to fill frame

Move Freely

Show Edit Controls

Handles

Orientation Clock

Edit Controls

Maintain aspect ratio

About Center [ALT]

Begin/End
Animation
Controls
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The Rotation Clock works like a clock. There are two hands on it. The larger hand 
represents the degree of rotation relative to 0°, which is straight up. The smaller hand shows 
the number of times the crop area has been rotated through 360°.

The crop area can be rotated to simulate camera rotation.

When you right-click anywhere in the Pan/Crop dialog, a shortcut 
menu appears:

•Restore returns the crop area to full frame.
•Center moves the crop area to the center of the frame.
•Flip Horizontal flips event left to right.
•Flip Vertical flips event top to bottom.
•Match Output Aspect sets the x,y ratio to the output value.
•Match Source Aspect sets the x,y value to the source media.

For more information, see Scrolling titles - Pan/Crop technique on page 72.

Animating effects

Effects can all be animated using the Begin/End buttons found in the Video FX dialog. By 
changing the Begin properties of an effect, and then changing the End properties to 
something different, VideoFactory smoothly animates the intervening frames.

To animate an effect:

1. Click the Begin button in the Video FX window on the tab of the effect you want to 
animate (e.g. the Crop tab).

2. Adjust the parameters of the effect.

3. Click the End button.

4. Adjust the parameters for the end of the effect.

5. Click the Play button to preview the animation.

You can reset the End button settings by clearing the check box next to the button.

225° 720°50°
(360° x 2)
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Working with images

Still images can be used in VideoFactory for a number of purposes including slide shows, 
overlay graphics, and titles. Images are inserted into projects just like any other media files 
and become events when inserted onto tracks. The default length for an image event when 
it is first inserted is five seconds, but this duration can be modified by dragging the edges to 
any length. Images cannot be looped, but share many characteristics with video files, 
including transparency. 

There are many image formats that can be imported into VideoFactory: BMP, JPG, PNG, 
PSD, and TGA. The best formats for video are PNG or TGA. JPG is not the best format for 
video because it is already compressed (which makes it an excellent format for the Internet). 
This does not mean that you should not use JPG images, but other uncompressed formats are 
better (BMP, PSD, etc.). PNG (and TGA) files can also include Alpha Channel 
information, which is one of the cleanest methods of creating transparency for overlays.

A slide show composed of still images and an accompanying sound track can be an excellent 
way to show off your pictures. Multiple images can be selected and inserted together to 
instantly create a slide show. Importing high-resolution still images and using the Pan/Crop 
tool can add interest to an otherwise static slide show.

To automatically create a slide show:

1. Select all of the images you want to use in the slide show in the Explorer. Use the Ctrl 
keys and Shift keys to select multiple files.

2. Drag these files to the timeline.

Note: It is best to use images that are the 
same size as your project’s frame size (unless 
you plan on using the Pan/Crop tool). You 
may also need to change the Pixel Aspect Ratio 
of an image file to get it to display correctly.

Scrolling titles - Pan/Crop technique

Scrolling titles can be effectively produced using the Pan/Crop dialog. This technique is 
especially effective for very long title sequences. For more information, see Text on page 109.
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To create scrolling titles - Pan/Crop:

1. Click the Text button ( ) and enter the complete set of credits. For more information, 
see Text on page 109.

2. Set the Height equal to 2,048. Leave the Width of your project’s width (default).

3. Enter the list of credits into the text box.

4. Click the Pan/Crop tab. The box defined by the 
broken line represents the cropped area. At this 
point, the dimensions of the box are equal to 
the source. Since the crop area always fills the 
screen, the titles all appear in a narrow band in 
the middle of the Video Preview window.

5. Right-click the Crop Area and choose Match 
Output Aspect. This will set the size of the Crop 
Area to the same size as your project’s final 
output (e.g. 720x480).

6. Resize the Crop Area by entering the numbers 
in the Size boxes. The Crop Area should be the 
same size as the final frame size (720x480 for 
example). After resizing, only a small portion of 
the middle of the titles is visible in the Video 
Preview window.

The size of the Crop Area changed to 720x480.
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7. Click the Constrain Motion button ( ) until it is in Move in Y Only mode ( ). This 
keeps the titles vertically aligned.

8. Drag the Crop Area box to the top 
of the titles. Position it so that the 
first credit is just below the Crop 
Area. This defines the starting 
position of the animation: the 
Begin button is depressed.

9. Click the End button to set the 
final position of the Crop Area.

10.Drag the Crop Area box to the 
bottom of the title sequence.

If you preview the video at this point, 
the titles appear to move up from the 
bottom, across the screen, and off of 
the top. What is actually happening 
is that the Crop Area is moving 
down across a title sequence.

You can reset the End button settings by clearing the check box next to the button.

Optimizing previews

Timing and synchronization are critical aspects of any multimedia production and real-time 
playback is a necessary feature. Because complex multimedia projects are very challenging 
for any computer, VideoFactory uses a number of techniques to maintain the timing of 
playback even though the computer may not be able to process the data quickly enough.

Dropping frames

VideoFactory automatically drops video frames when the computer can’t keep up with 
playback. Visually, this means that you are not seeing a perfectly rendered preview of your 
project. The advantage to this is that precise synchronization is maintained and video and 
audio can be accurately and quickly positioned. The process of dropping frames is handled 
by VideoFactory and cannot be changed.

Reducing the resolution or quality

The resolution of the Video Preview window and the quality of the rendering can be 
adjusted to improve playback. Lower-resolution previews are visually less clear but allow 
VideoFactory to display more frames per second. This may be particularly important with 
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projects that use a lot of overlays, transitions, and special effects. Click the Video Preview 
Quality ( ) button to choose the resolution and quality settings from the drop-down 
list. The default setting is Good Quality.

Pre-render Video in Loop Region

There are times where nothing but a full, high-quality preview will do. In these cases, 
VideoFactory will take the time necessary to render the portions of your project that need 
extra processing and create a preview file on your computer of the project as it will appear in 
the final render. This can take anywhere from a few seconds to a few minutes, depending on 
the length and complexity of the preview. Once these temporary files have been created, 
VideoFactory will use them whenever it needs to playback those sections of the project.

To create a partial full-quality preview:

1. Create a selection area of the portion of your project that you want to preview.

2. From the Tool menu, choose Pre-render Video in Loop Region [Ctrl+M].

3. Select the type of preview file to create. Click the Custom button to configure any 
compression options.

4. Click OK.

VideoFactory will delete these preview files when a project is closed. To reuse these preview 
files the next time you open a project, from the Options menu, choose Preferences and, in 
the Preferences dialog, select Save active previews on project close. The location of these files 
can be set by choosing a Temporary files folder in the same dialog. Ideally, this folder should be 
on a different physical drive from where Windows is installed. Only file types that can be 
both read and written by VideoFactory can be used to create preview files. Some formats 
that cannot be used include *.asf, *.rm, and *.wmv. Pre-rendered preview files can be 
deleted from your hard disk by choosing Clean Pre-Rendered Video from the Tools menu.
CHP. 5 ADVANCED VIDEO



76
As long as no changes have been made to the project, sections that have been previewed 
this way will not need to be re-rendered in the future, increasing preview playback speed and 
performance. A yellow bar appears at the top of the timeline indicating the mixed to 
preview section.

Previewing an entire project

A compressed preview of the entire project can also be created. This is equivalent to doing a 
final render to create a finished movie.

To create a preview of the entire project:

1. From the Tool menu, choose Preview in Player.

2. Select the type of preview file to create (e.g. *.avi). Select a Template or click the 
Custom button to configure any compression options.

3. Click OK.

The progress bar at the bottom-left corner of VideoFactory displays the progress of the 
render. When it is finished, it will automatically playback. 

Preview range
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Recording Audio 
and Audio FX
VideoFactory is a full featured recording studio, allowing you to record audio into a stereo 
audio track while simultaneously playing back existing audio and video tracks. Audio is 
recorded to a media file on your computer and into an event on the timeline.

The included audio FX can be used to improve the quality of the audio in a production, or 
can be used as special artistic effects. Audio effects are applied to tracks, to all of the events 
within a track, or to the final output.

Recording

Recording into an empty audio track is the easiest way to record new material into an 
existing project. VideoFactory will create the new event’s waveform during the recording 
process. The recorded event, like all events in your project, will have an associated source 
media file. By default, VideoFactory stores recorded media files in the VideoFactory program 
folder. However, you may specify where recorded media files are stored. For more information, 
see Specifying where recordings are stored on page 81.

On the Track View, the cursor position indicates where recording will begin. Positioning the 
cursor is not always necessary since it is easy to edit and move the event after recording.

To record into an empty track:

1. Click in an audio track on the timeline where you want to begin recording.
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2. Start recording by clicking the Record button ( ) on the Track Header or by selecting a 
track and pressing the  shortcut keys.

Recording will begin at the cursor's position and continue along the timeline until you stop 
recording.

3. Click the Record button again, click the Stop 
button ( ) on the Transport bar, or press the 

 key on your keyboard to stop recording. A 
small dialog opens displaying the name and 
location of the file or files that were just created. 
Click Done to return to the main workspace.

Recording a voiceover

Voiceover narrations are an important part of many types of productions. One of the most 
important features of VideoFactory is the ability to record live audio directly into a project 
while previewing the project itself. This can be done while simultaneously listening to the 
audio tracks and watching a preview of the video. Best results are achieved using 
headphones to monitor playback.

To view the Video Preview window, click the Options menu and make sure Simultaneous 
Play & Record is selected. The strength of recording narrations this way is that it is very easy 
to stop, restart, and edit the resulting audio events.

Recording into a time selection

By making a time selection, you specify where along the timeline to record. The time 
selection also determines how long VideoFactory will record. Any selected events that occur 
within the time selection will be split and the recorded data will be placed into the time 
selection. For more information, see Recording into an event with a time selection on page 80.

To record into a time selection:

Ctrl + R

Record

Space
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1. On the Marker bar, click and drag to make the time selection. You may adjust the time 
selection by dragging the selection bar’s starting and ending points.

2. Click the Record button ( ) to begin recording.

VideoFactory will display the event’s waveform as it is recorded and automatically stop 
recording when the cursor reaches the end of the time selection.

To record multiple takes, click the Loop Play button ( ) on the Transport bar.

Recording into an event

By recording into an event, the exact length of the recording is controlled by the duration of 
the envelope. The edges of the selected event serve as the punch-in and -out points that 
VideoFactory uses for recording. Recording into an event allows you to establish pre-roll 
before recording, which gives you time to prepare before recording starts.

The existing event that you record into is not affected or deleted. Instead, the event will 
now contain two media files, each listed as a separate take in the event.

To record into a selected event:

1. Place the cursor before the event to allow for pre-roll.

2. Press the  key and click the event to select it.

Note: You may record into multiple events by 
pressing the Ctrl key and make your selections.

Loop bar

Loop play

Recorded waveform

Ctrl

Selected Non-selected
eventevent
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3. Click the Record button ( ) to begin recording.

VideoFactory will display the event’s waveform as you record.

4. Click the Record button ( ), the Stop button ( ) on the Transport bar, or the  key 
on your keyboard to stop recording.

Recording into an event with a time selection

Recording into a time selection allows you to compensate for a pre- and post- roll during 
recording. The time selection is adjustable to increase or decrease the pre- and post-roll 
duration. During recording, the selected event’s edges serve as the punch-in and -out points. 
Multiple punch-in and -out points can be created by selecting more events within the time 
selection.

Using a pre-roll

The previous technique allows you to define the playback region with a time selection and 
sets the punch-in and punch-out points in the recording to the event boundaries. When the 
Record button is pressed, playback begins at the beginning of the time selection. The event 
is then filled with the newly recorded material. The audio file that is recorded to your hard 
disk is the full duration of the time selection. The event only contains a portion of the full 
recorded performance and can therefore be trimmed (both shorter and longer) and 
repositioned within the event.

Recording takes

You can repeatedly record into the same event to record a number of different takes. After 
multiple takes have been recorded, the take that appears on the timeline is called the active 
take. The active take is the last one recorded. Right-click an event with takes and, from the 
shortcut menu, choose Take. A submenu will appear with the event’s original file name (in 
this example, GuitarIntro) followed by the recorded takes, which are numbered sequentially. 
The active take will have a bullet next to it.

Space

Pre-roll Post-roll

Time selection bar - 

Punch-in Punch-out

defines the recorded
audio file’s duration.
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Specifying where recordings are stored

VideoFactory is a nondestructive audio-editing environment. Events within your project are 
actually references to media source files located on a storage device such as a hard drive. 
When you record into VideoFactory, the event appears on the timeline while its media 
source file is written to your hard drive. By default, VideoFactory stores recorded media 
source files in the VideoFactory program folder. However, you may specify where 
VideoFactory writes and stores recorded media source files.

To change where recorded media source files are stored:

1. From the File menu, choose Properties or press the  shortcut keys. The Project 
Properties dialog appears.

2. Click the Audio tab to display the project’s audio properties.

3. Click the Browse button. The Recorded Files Folder dialog appears.

4. Navigate to the hard drive or folder where you want VideoFactory to write and store 
recorded media source files.

5. Click the Save button to set the destination drive or folder.

Click the Cancel button to leave the current destination the same.

Note: Check Start all new projects with these 
settings to store recorded media source files to 
the same location in every new project. 
Otherwise, VideoFactory will use its default 
settings.

Using an external sound editing program

VideoFactory is a nondestructive editing environment, which means that the original source 
files remain unchanged by any editing done in VideoFactory. Destructive (constructive) 
edits may be done in a separate application such as Sonic Foundry’s Sound Forge® to modify 
the actual source media file. By setting up a separate sound editor, you can quickly access the 
program from VideoFactory via the Tools menu or  shortcut keys.

Alt + Enter

Ctrl + E
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Setting up the sound editing program

If you already had Sound Forge loaded on your computer when you installed VideoFactory, 
the installation should have detected it and made it your default sound editing program. 
However, if you do not have Sound Forge or want to specify a different sound editor, you 
may do so in the Preferences dialog. 

To set up the sound editor program:

1. From the Options menu, choose Preferences. The Preferences dialog will appear.

2. In the Preferences dialog, choose the Audio tab.

3. Click the Browse button to the right of the Location of preferred audio editor item. The 
Preferred Audio Editor dialog will appear.

4. From this dialog, navigate to the application to use for editing audio files.

5. Select the application’s executable icon (*.exe) and click Open to set the application as 
your default sound editor.

The application’s path will be displayed in the Location of preferred audio editor field.

 Opening a sound editor from VideoFactory

All events in your VideoFactory project are actually references to media files on a storage 
device. When you edit an event in a sound editor, you are editing the media file to which 
the event is referenced. Any changes you make and save in the sound editor are permanent 
and will be reflected in the event in your VideoFactory project. 

To edit an event in the sound editor: 

1. Click on the event that references the file to be edited to select it. You need to select the 
entire event.

2. From the Tools menu, choose Open in Sound Editor or press the  shortcut keys.

Your selected sound editing application will open and the event’s referenced media file will 
open in the application. Make the necessary changes and save the file in the sound editor. If 
you keep the media file’s name and location the same, its event will be updated immediately 
in your project. However, if you change the media file’s name or location, you will need to 
import the edited (new) file into VideoFactory.

Ctrl + E
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Using audio track FX 

VideoFactory includes Sonic Foundry’s ExpressFX audio effects: Amplitude Modulation, 
Chorus, Delay, Equalization (EQ), Flange, Reverb, and Stutter. These effects can be used at 
the track level in any order you specify and are accessed by clicking the Track FX ( ) 
button on any audio track.

Saving presets

Each effect has a number of preset settings that can be used to quickly determine the 
behavior of the effect. There are also a number of controls within each effect’s dialog that 
can be used to customize the effect. Any custom configurations can be saved to a new preset.

To save custom presets:

1. Enter a preset name in the drop-down list field.

2. Set the EQ controls on each band that you want to customize.

3. Click the Save button ( ) to save the preset. 

Note: You may delete any presets that you 
have saved by selecting it from the list and 
clicking the Delete button ( ).

Creating a track plug-in chain

A plug-in chain is a list of all of the effects that have been applied to an event or track and 
the order in which they have been used. A plug-in chain can contain one or more effects. 
The same effect can be added to a single track more than once.

After the plug-in chain is created, the entire track will be processed by each effect in their 
respective order. The effects are cumulative so, in some cases, you may want to rearrange 
their order to achieve the desired effect.

Adding effects via the Plug-in Chooser dialog

The Plug-in Chooser dialog is accessed from the track to which you are adding the plug-in 
chain.

To add a plug-in chain via the Plug-in Chooser dialog:

1. Click the Track FX button ( ). The Track FX dialog appears.
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2. On the Track FX dialog, click the Edit Plug-in Chain button ( ). The Plug-in Chooser 
dialog will appear. This dialog displays the track number, plug-ins already in the chain, 
and the plug-ins that can be added to the chain.

3. Select the plug-ins that you want to add. The plug-ins that you add will appear in the 
chain area. There are three ways to add a plug-in to the chain:

• Double-clicking the plug-in.
• Dragging the plug-in to the chain area.
• Selecting the plug-in and clicking Add.

4. Click OK to save the track’s plug-in chain and close the Plug-in Chooser dialog. 

Arranging the audio plug-in chain order

Plug-ins are cumulative during playback. For example, when the track’s signal passes through 
the EQ, it uses the EQ’s settings as it passes through the Distortion effect and then the signal 
is sent to the next plug-in, etc. Because of this cumulative effect, you may need to arrange 
plug-ins in a certain order so that one plug-in’s processing does not adversely affect the next 
plug-in on the chain. There is no right or wrong way to order plug-ins, but some plug-ins 
work better when they follow another. However, the plug-in’s order in the chain is strictly 
based on your preferences and desired output. 

You may arrange plug-ins on either the Track FX dialog or the Plug-In Chooser dialog. 
There are two ways to arrange plug-ins in your chain:

• Drag the plug-in to a new location in the chain.
• Select the plug-in and click either the Move Left ( ) or Move Right ( ) button.

Plug-in already contained in the chain
This area displays the plug-in chain
and the order of selected plug-ins
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Bypassing plug-ins on the chain

You may bypass plug-ins on the chain by clearing the check box on a specific plug-in or 
right-clicking the plug-in to display a shortcut menu and choosing Bypass. The plug-in will 
remain bypassed until you enable it again. Bypassing a plug-in prevents its processing on the 
track.

You may bypass plug-ins either from the Track FX dialog or the Plug-In Chooser dialog.

Removing plug-ins from a chain

You may remove plug-ins from a chain at any time. Chain plug-ins may be removed from 
either the Track FX dialog or the Plug-In Chooser dialog. Right-click the plug-in’s button in 
the chain to display the shortcut menu and choose Remove.

Saving plug-in chains

VideoFactory allows you to save plug-in chains, so that you may use them again on other 
tracks with other projects. If you use a combination of plug-ins often, saving them will save 
you time when editing a project. The preset chains that you save retain their order and 
settings that you have applied.

Audio effects dictionary

The following section details the parameters and controls of each of the included audio 
effects. The tracks in your project that use the same effect may be set independently of each 
other. For example, if you are applying Distortion to Track 1 and to Track 2, each track can 
have different distortion settings.

Amplitude modulation

Amplitude Modulation adjusts the gain of a signal at a specified frequency. You can use 
modulation to create tremolo guitar effects or to increase the spatial intensity of a recording.

• Rate - Drag this slider to control the frequency (0.1 to 5000 Hz) of the modulation. A 
faster rate causes the amplitude to modulate at a higher frequency, giving the effect a 
higher pitch. A lower rate leads to a lower effect pitch.

• Depth - Drag this slider to specify how much (0 to 100%) the signal is modulated. At 
100%, the amplitude modulates from silence to full volume. At 50%, the modulation goes 
from half to full volume. At 0%, there is no modulation (the output is always at full 
volume).

Effect bypassedEffect enabled
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• Modulation/Original - This controls the strength of the effect.

Chorus

The Chorus effect simulates the sound of several of the same instrument playing the same 
notes. Adding a Chorus effect works by adding very short delays and modulating the delay 
times.

• Rate - Drag this slider to determine how fast the delay time is modulated. Choose values 
of 0.3 to 1 Hz for subtle modulation. Higher values will produce more intense effects.

• Depth - Drag this slider to specify how much (1 to 100%) the modulation varies from the 
original signal. Deeper settings cause the Chorus effect to be more pronounced.

• Chorus/Original - This controls the strength of the effect.

Delay

The Delay effect is used to create subtle ambiance, slap-back echoes and other interesting 
effects.

• Delay (ms) - Drag this slider to set the interval between the dry and delayed signals.
• Decay - Drag this slider to specify how long it takes for the echoes to fade to silence. 

Moving the slider completely to the left causes only a single echo to be heard.
• Delay/Original - This controls the strength of the effect.

Distortion

The Distortion effect precisely controls the gain at all input levels of a signal. It can be used 
to create dramatic to subtle distortion, simple compression, expansion, and noise gates.

• Enable hard clipping - Select this check box to distort the entire signal. This can be hard 
on your speakers and your ears. Before enabling hard clipping, drag the Distortion/
Original Mix fader all the way to the bottom. After you’ve enabled hard clipping, slowly 
slide the fader up until you get the distortion you’re looking for.

• Distortion - Drag this slider to specify the amount of overdrive applied to the signal. If 
the original sound file is too quiet, even significant levels of distortion may not be heard 
unless you select the Enable hard clipping option.

• Slew - Drag this slider to control how much the sound wave is allowed to change over 
time, which can give useful effects even without applying any distortion. Using a low slew 
rate means that the signal is not allowed to deviate very much at all, causing a bubbling 
effect. Low slew rates should be used on audio signals with headroom to keep clipping to a 
minimum. Increasing the slew rate allows the signal to change more dramatically, 
meaning the signal will be allowed to follow its original path.

• Distortion/Original - This controls the strength of the effect.
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Equalization (EQ)

The Equalization effect is used to boost or attenuate (cut) specific frequencies in a track and 
can be used to adjust the track’s overall tonal characteristics.

• Bass - Drag this fader to control the volume of the lower frequencies in the signal.
• Mid - Drag this fader to control the volume of the middle frequencies in the signal.
• Treble - Drag this fader to control the volume of the higher frequencies in the signal.
• EQ/Original - This controls the strength of the effect.

Flange/Wah-Wah

The Flange effect is used to create the sweeping effects often heard in guitar recordings from 
the 1960s and techno-sounds of today.

• Flange/Wah-Wah - Select Flange or Wah-Wah to specify which effect is applied to the 
sound. 

• The flange effect is created by mixing a modulated delay signal with the original signal. 
The wah-wah effect is created by varying the amount of low and high frequencies in the 
signal over time.

• Rate - Drag this slider to specify how long it takes the Flange/Wah-Wah effect to 
complete a full sweep. Slower rates create gentler sweeping effects, while faster rates lead 
to a pronounced chopping of the sound.

• Depth - Drag the slider to specify how much the signal is affected by the Flange/Wah-
Wah effect (from 1 to 100%). A low setting creates subtle changes to the sound. At 
higher settings, the changes to the sound are more obvious.

• Flange/Original - This controls the strength of the effect.

Reverb

The Reverb effect recreates the space that is typically lost with close-miking techniques. It 
may also be used to create effects by placing sounds in spaces where they would normally 
never be heard.

• Room type- Choose a Room type from the drop-down list. These modes are the basic 
types of reverb simulation available to you in the Reverb dialog. Rather than determine 
the length of the reverb, these modes determine parameters such as diffusion and the 
reflective patterns of the echoes that make up a reverb.

• Room size - Drag this slider to specify the time between the initial sound and the start of 
the reverb. The length of this time gives the human ear cues about how big a space is. 
Long times are usually associated with large spaces. Drag the slider to the right to increase 
the time or left to decrease the time.

• Liveliness - Drag this slider to specify how long it takes for the reverb to fade away. In a 
dampened room, the walls absorb the sound quickly. In a bright room, such as a 
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gymnasium, the walls reflect most of the sound, and send it bouncing around the room. 
The reverberation in a bright room lasts substantially longer than in a damp room.

• Reverb/Original - This controls the strength of the effect.

Stutter

The Stutter effect creates a strobing sound pattern by rapidly inserting brief periods of 
silence.

• Add space - Select this option when working with stereo files to cause the stutter to 
alternate between the left and right channels, which serves to spread out the sound.

• Silence - Drag this slider to specify the duration (0.01 to 200 ms) of the muting that is 
applied periodically to the signal. When long periods of sound are muted, a distinct 
stuttering effect is heard. As the length of muting becomes too short to distinguish with 
the human ear, strange pitching effects occur.

• Sound - Drag this slider to specify the duration (0.01 to 200 ms) of the sound output 
between periods of muting. When long periods of sound are heard between periods of 
silence, the Stutter effect is more obvious. As the length of sound becomes too short to 
distinguish with the human ear, strange pitching effects occur.

• Stutter/Original - This controls the strength of the effect.
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Video 
Transitions
Transitions

Transitions occur between two video events and are an entertaining and interesting method 
of switching between scenes or shots. Too many transitions in a single production however 
can distract from your movie. Most professional productions, on television or on the big 
screen, use only two types of transitions. The first is a simple cut, where one scene 
immediately cuts to the other without delay or effects. The other is a fade, otherwise known 
as a crossfade or a dissolve.

Cuts

A cut is actually not a transition. Instead, the last frame from an event is immediately 
followed by the first frame of the next event. This is what happens when with two adjacent 
events on the VideoFactory timeline, either in the same track or in different tracks. This can 
also happen when an event is punched into another. 

Cuts can be converted to a transition effect by dragging a transition to the cut position. This 
will only work if the two events involved in the cut have enough media trimmed back (from 
the end of event one and the beginning of event two) to be used in the transition effect.

Adjacent events Events on different tracks Punch-in events
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Crossfades

Crossfades or dissolves can be created automatically in VideoFactory by simply overlapping 
two video events on the same track. This is the default behavior when two events are 
overlapped and can be turned on and off. For more information, see Automatic crossfades on 
page 46.

Transition effects

The remainder of this chapter deals with the more colorful and visually interesting methods 
of transitioning between two events.

To add a transition effect:

1. Insert a video event onto the timeline or on a track.

2. Insert another event so that it overlaps the first to create an automatic crossfade.

3. Click on the Transition tab in at the bottom of the program.

4. Select the type of transition you want to use from the left side of the window.

5. Select the specific Preset from the list. Watch the animation of the preset to preview the 
effect.

6. Drag the preset to the timeline area where the two video events overlap (the crossfade 
area).
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The duration of a transition is automatically determined by the amount of overlap between 
the two events. As with other events in VideoFactory, the precise duration of a transition 
can be controlled by dragging the edges in and out.

Note: A transition between two events is 
attached to the second event of the pair. The 
parameters for this transition can be found on 
the Transition In tab in the Video FX window of 
the second event.

Transitions to and from black

Transitions can also be added to the beginning or ending of any event without transitioning 
into another event. The effect then acts as a transition between the video event and black. 
Instead of a simple fade-to-black, this allows you to transition-to-black using any of the 
transition effects. This can be an especially interesting technique when used in 
combinations with overlay titles. To add a transition effect to the beginning or ending of an 
event, drag the transition from the Transition window to the edge of the event. The details 
of the transition can be modified on the Transition In (beginning) and Transition Out (ending) 
tabs of the Video Event FX window.

Previewing a transition

The easiest way to preview a transition is to set the preview area to the duration of the 
transition and then loop the playback. You can then adjust the transition while it is playing, 
quickly making your changes in real-time.

To preview a transition:

1. Double-click the transition on the timeline.

2. Click the Loop button ( ) to toggle automatically repeated playback. The preview area 
bar is a darker color when Loop is turned on.

3. Click the Play button ( ), or press the  key.

Transition between two events Transition in/out of a single event

Space
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Complicated transitions may need to be 
rendered. From the Tools menu, choose 
Render to Video Preview.

Modifying a transition

All of the transitions in VideoFactory include preset settings to create a perfect transition. 
Most transitions are highly customizable with many attributes that can be changed.

To modify a transition:

1. Click the FX button ( ) on the Transition event. The Transition In or Transition Out 
tab is brought to the top of the Video FX dialog.

2. Change the parameters. Changes are updated in real-time in the Video Preview window.

The Transition In tab controls the aspects of a transition at the start of an event, while the 
Transition Out tab controls the transition at the end of an event. Each transition has 
individual controls and variables, the details of which are discussed in the Transition 
Dictionary. For more information, see Video transition dictionary on page 93.

After modifying a transition, it is possible to save the changes as a preset for use at a latter 
time. Default and custom presets can be accessed from the Preset drop-down list.

To save a variation as a preset:

1. Click the name in the Preset drop-down list.

2. Enter a name for the new preset.

3. Click the Save Preset button ( ).

Any additional changes can be instantly saved to the custom preset by clicking the Save 
Preset button. Changes cannot be saved to the (Default) preset.
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Video transition dictionary

There are a number of transition effects 
available in VideoFactory and each has 
its own variables and parameters that 
can be customized. Many of the 
examples in this section are based on 
the video track pictured at the right. The examples transition from the beach scene into the 
ornate temple roof. The samples in the Transition window in VideoFactory display animated 
thumbnails of the effects: click on a transition thumbnail to view this animation and select a 
preset to see the variations. The following is an alphabetical listing of these effects and their 
options.

Additive Dissolve

Dissolves are also commonly known as fades. Additive simply means that the B roll video 
sequence is gradually added on top of the A roll video, with the transparency of A increasing 
while B’s transparency decreases until it is completely opaque. Because it is an additive 
dissolve, the video becomes brighter during the transition. This transition is similar to an 
Auto-crossfade or Fade.

Barndoor

This transition effect is a variation of a wipe 
transition. As the name implies, this wipe moves in 
two direction, not unlike two barn doors. Video 
transition barn doors however, can move in a number 
of different directions, vertically or horizontally.

Orientation Select Horizontal / Vertical for 
doors that open side to side or 
top to bottom.

Direction The transition can start from 
the outside and move In 
towards the center or start at 
the center an move Out towards 
the edges.

Border The barndoor transition does not have a border by default, but you can add 
one with the following parameters. No border is visible if the Size and 
Feather sliders are set all the way to the left.

Size Move the slider to the right to create a larger border.
Feather Feather determines how crisply the edge appears. Higher values yield a 

softer edge.
Color Use these color boxes to select a color for the border.
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Clock Wipe

This wipe effect moves in a circular pattern, either 
clockwise or counterclockwise.

Cross Effect

This is a composite transition effect that uses a crossfade combined with a Zoom, Pixelate or 
Blur transition. The following illustration shows a Pixelate Cross Effect where the first video 
gradually becomes more and more pixelated, then crossfades into a pixelated second event, 
which finally resolves to the second event, thus completing the transition.

Direction Select Clockwise or 
Counterclockwise.

Feather Angle Determines how much of the 
edge is feathered or 
softened.

Fade Range Determines the duration of the crossfade that occurs at mid transition. The 
fade takes place across the entire transition for a value of 1.

Effect Select the type of transition to combine with the crossfade: None, Zoom, 
Pixelate or Blur.

Apply to Determines which events are involved with the zooming aspects of this effect: 
Source, Destination or Both.

Max Zoom Sets the maximum amount of zooming at the mid point of the transition: 
from 1 to 128%.

Source Center Determines the center of the first event (transition from).
Destination Center Determines the center of the second event (transition to).
Map Drag the center dots (red = source/ blue = destination) to visually determine 

the center location.
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Iris

This effect allows you to select the shape of the 
transition as it grows. The shape can be repeated any 
number of times in rows and columns and can be 
surrounded by a border.

Linear Wipe

At first glance, the Linear Wipe, Push, and Squeeze transitions look very similar. In a Linear 
Wipe transition, a line moves across the video, revealing the second video, which was always 
below the first and is unmoving. In a Push, the second video itself moves onto the screen as 
the first one moves off. A Squeeze distorts the transitioning video events, squeezing one as 
the other expands.

Center Enter the coordinates of the center of the effect into the text boxes or drag 
the circle on the position map to the desired location.

X Repeat / Y Repeat X Repeat is how many times the shape is repeated across the image from left 
to right (columns) and Y Repeat is the number of times the shape is repeated 
from top to bottom (rows).

Iris Shape Sets the shape of the iris.
Feather Determines how smoothly the border fades into the background.
Border Determines the size of the border in pixels.
Border Color Use the color boxes to select a color for the border.

Angle Use the slider to control the direction the Linear Wipe comes in from.
Feather This sets the size and softness of the edge of the Linear Wipe.

Linear Wipe SqueezePush
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Push

Event two pushes in over the first event, from any direction, replacing it. See the illustration 
accompanying the Linear Wipe effect.

Slide

In this transition event two slides over event one (Slide In) or event one slides away off 
screen, revealing event two (Slide Out).

Direction Select the direction for the transition to progress from: Up, Down, Left or 
Right.

Push off previous image The first video pushes the second video off of the screen when this is 
selected. When not selected, the second video merely slides over the first, 
with the first remaining unmoved.

Border The following three controls modify the border on the effect.
Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.

Angle Determines the angle of the transition’s movement.
Direction Slide In: event two slides over event one. Slide Out: event one slides off screen.
Border The following three controls modify the border on the effect.

Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.
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Spiral

In this transition event two starts small and grows as it spirals in over event one (Spiral In) 
or event one spirals away off screen, shrinking as it reveals event two (Spiral Out).

Split

In this effect, one of the transitioning events is split apart into four sections and gradually 
cover, or reveals, the other event. The illustration uses Split Mode: Squeeze and Direction: In.

Turns Sets the number of spirals.
Zoom Determine the initial zoom level (Spiral In) or the final zoom level (Spiral Out).
Orientation Determines where the spiral motion begins.
Motion Determines the angle of the transition’s movement.
Direction Spiral In: event two spirals over event one. Spiral Out: event one spirals off 

screen.
Border The following three controls modify the border on the effect.

Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.

Center Determines the central offset of the transition. Drag the circle to move the 
center.

Split Mode Possible modes: Push, Wipe, or Squeeze. See the illustration accompanying 
the Linear Wipe transition’s explanation for more information.

Direction Out: event one splits to reveal event two. In: event two slides in and over 
event one.

Border The following three controls modify the border on the effect.
Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.
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Squeeze

This effect is similar to Push and Wipe. In a Squeeze effect however, the entire contents of 
both videos is visible for the duration of the effect. See the illustration accompanying the 
Linear Wipe effect for more information.

Swap

In this effect, events one slides out of the way and then exchanges places with event two, 
which comes to the forefront.

Start The effect can start from the Top or Bottom, Left or Right, or emerge from 
the Center either Horizontally or Vertically.

Squeeze previous image The first video squeezes the second video off of the screen when this is 
selected. When not selected, the second video merely slide over the first, with 
the first remaining uncompressed.

Border The following three controls modify the border on the effect.
Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.

Direction Determines the initial direction that event one takes during the swap.
Border The following three controls modify the border on the effect.

Size Sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.
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Zoom

The second video appears on top of the first as a point at the beginning of this effect and 
gradually expands to cover the entire screen.

Location Drag the circle on the location map to determine the starting point of the 
effect.

Border The following three control the border, if any, on the effect.
Size This sets the width of the border.
Feather Determines how smoothly the border fades into the background.
Border Color Use the color boxes to select a color for the border.
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Video FX
Video FX are any of a number of special effects that can be used to alter, enhance or correct 
video media.

Video FX

To view the Video FX window, from the View menu, choose Video FX or press Alt+9. Plug-
ins can be dragged to events, tracks or the Video Preview window.

To add an effect:

1. Select an effect from the left of the Video FX window.

2. Select a variation of the effect from the Preset list.

3. Drag the variation to a video event or the Video Preview window.

There are a huge variety of effects that are completely ready for you to drag-and-drop onto 
your projects, tracks, and events. The default settings may be enough for many people, but 
each effect has a handful of individual controls that allow you to customize the effects in 
precise detail. Multiple effects can be used on individual events.
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Using video FX

Adding a video effect to a video event is, like many other activities in VideoFactory, a drag-
and-drop routine. Video FX can be applied to events in the workspace or to an entire 
project.

To remove an effect:

1. Click the FX button ( ) on object with the effect applied to it (event or Video Preview 
window). This opens the Video Event FX dialog. 

2. Click the name of the effect that you want to remove.

3. Click the Remove Selected Plug-In button.

Video FX can also be temporarily disabled (turned off) by deselecting them (clearing the 
check box on the effect’s button). Since the effects are rendered very quickly in the Video 
Preview window, turning an effect on and off allows you to clearly see the results of the effect 
on your project.

Modifying FX

Most effects are highly customizable. Each has 
its own default settings that are adequate in 
most circumstances, but modifying these 
defaults is not difficult.

To modify an effect’s properties:

1. Click the FX button ( ).

2. In the Video Event FX dialog, click the Video 
FX tab.

3. Change the parameters in the Video Event 
FX dialog.

Changes you make will automatically be 
updated in the Video Preview window, using the 
current cursor position as the example.
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To save an effect preset:

1. Click the Preset text box. The name of the current effect is highlighted and the cursor 
begins blinking.

2. Enter a new name for the preset.

3. Click the Save button ( ).

To use a saved Preset, simply choose it from the drop-down list.

Ordering FX

There are a large number of effects in VideoFactory. Video FX can also be used in 
combinations of two or more for even greater flexibility. Adding additional effects to an 
event is simply a matter of dragging them onto an event. Effects are then arranged in a plug-
in chain in the Video Event FX dialog.

Effects that are selected with a check are active. You can toggle FX on and off by selecting 
and deselecting them. The effects are applied in the order that they appear. You can change 
this order by dragging the FX button to a new location in the chain or by clicking the FX 
Chain button. In the following illustration, you can see why the order of effects might be 
important.

In the image on the left, a Brightness and Contrast effect is applied first and then a Black 
and White effect. In the image on the right, the Black and White effect was applied first, 
removing the color, and then the Brightness and Contrast effect was applied. The mask 
created by the second example is much cleaner, even though all of the settings of the two 
effects are identical.
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Animating FX

Effects and transitions can all be animated using the Begin/End buttons found in the Video 
FX dialog. By changing the Begin properties of an effect, and then changing the End 
properties to something different, VideoFactory smoothly animates the intervening frames.

To animate an effect:

1. Click the Begin button in the Video FX window on the tab of the effect you want to 
animate (e.g. the Video FX tab).

2. Adjust the parameters of the effect.

3. Click the End button.

4. Adjust the parameters for the end of the effect.

5. Click the Play button to preview the animation.

The beginning and ending parameters of the Add Noise effect have been adjusted so that 
there is no effect at all at the beginning and the effect has a maximum amount of noise at 
the ending.

The results of gradually easing into an effect.
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Video FX dictionary

Video FX plug-ins in VideoFactory cover a broad range of special effects from basic color 
correction tools to bizarre warping effects.

Add noise

This effect adds static or noise to a video sequence. When added to a simple solid-colored 
background with a monochrome setting and animated, a pattern is produced that is similar 
to a television that is not tuned to any station.

Black and White

This effect removes all color information from an image without altering the luminosity. 
This converts a video to black and white. This can be an important effect when used in 
combination with other effects.

Brightness and Contrast

This is a straightforward correction effect that can be used to improve video with exposure 
problems. Move the Brightness slider right to increase the overall brightness. 0 is no 
correction, negative values decrease brightness, and positive values increase brightness. 
Contrast is defined as the absolute difference between the darkest and lightest areas of an 
image or video. It is sometimes perceived as influencing the “sharpness” or crispness.

Amount Determines the strength of the effect.
Monochromatic Select this option to make the noise all one color. When unselected, the 

static will be many random colors.
Gaussian Noise This is a different mathematical method of generating noise. In general, 

this produces a stronger effect.
Animate Check this box to make the static move in a random way.

Original
Regular

Gaussian Noise
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Color Balance

This effect can be used to improve the color in a video clip or can be used to creatively 
modify the video.

Gaussian Blur

This effect alters the apparent focus of the video and blurs or softens its appearance. It can 
also be used to smooth some types of noise and can also be used as a corrective effect.

HSL Adjust

HSL stand for Hue, Saturation, and Luminance (sometimes called Lightness or Brightness) 
and is another correction effect that is used to alter the display of colors in a video. In 
addition to improving an image or video event, this effect can be used in many creative and 
artistic applications.

Blur Range Sets the strength of the blurring by determining how many pixels in a block 
are blended together. Use the Pixels slider or enter a specific value in the 
text box.

Channels Select All or only the specific color channels (Red, Green, or Blue) that you 
want to blur. If the video or image has an Alpha channel, you can use that 
as the basis of the blur, which can sometimes improve transparency and 
mask blending.

Hue Adjusting the hue changes the colors in an image. Hue deals with color in a 
different way than the RGB/CYMK method of a color balance effect, with 
Hue represented by a 360 degree color circle. Either end of the hue slider 
(0.0000 or 1.0000) leaves the hue unaltered.

Saturation Controls the intensity of the particular hue selected with the hue slider. 
Moving the slider all the way to the left (0) removes all hue from the image, 
converting it to grayscale.

Luminance Controls the overall brightness of the image or video. A value of 1.0000 
leaves the brightness at its original level.
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Invert

This effect reverses the complimentary colors and the brightness in an image or video, 
giving it a photo negative effect.

Pixelate

Pixelate creates the effect of viewing the video at a lower resolution, making it appear 
blocky. This is very effective when used with keyframe animation to move from highly 
pixelated to the unaltered video as a type of transition. The X and Y sliders control the 
dimensions of the pixels.

Sepia

Sepia is a specific color tint associated with old movies. The default settings will produce a 
standard sepia tone, but you can use the color boxes to tint your video to any color that you 
want.

Color Boxes Select the color of the tint effect you want to use.
Blending Strength Determines the overall opacity/transparency of the color effect.
Blending Falloff Determines how smoothly the effect mixes with the source video’s original 

colors. Values closer to 1.000 (right) will have less color overall and appear 
more grey.
CHP. 8 VIDEO FX



108
Sharpen

This correction effect is the opposite of the Blur effect. It finds and emphasizes areas of 
contrast in the image, increasing the video’s crispness. The original on the left in this series 
is a bit out of focus. While the effect is subtle, the middle image is a little sharper, although 
some artifacts are visible on close inspection. The last image has a much higher sharpen 
setting and is noticeably noisy.

Wave

This effect distorts the video horizontally, vertically, or in both directions. You can control 
the number and height of the waves as well as their position. When animated and combined 
with a transition, this effect can produce a great dream-sequence or underwater effect. See 
the illustration below for a demonstration of the controls.

Vertical/Horiz. Waves Controls the number of waves.

Vert./Horiz. Amplitude Amplitude refers to the height of the waves.

Vertical/Horizontal Phase Sets the position of the waves on the screen.

Original image
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Text

Text and titles are typically added to the first video track, initially labeled the Video Overlay 
track. Visual media files added to the top track appear over media in the second lower track.

To add simple titles:

1. Position the cursor on the timeline in the first track where you want the title event to be 
inserted.

2. Click the Create Text button ( ) on the toolbar.

3. Enter a title in the text box on the Text tab of the Video FX dialog.

4. Adjust the various parameters (e.g. Font, Style, color).

Text can also be inserted into a track by choosing Text from the Insert menu. A video event 
that contains the generated Text is inserted into the timeline.

To edit inserted Text:

1. Click the FX button ( ) on a text event.

2. Enter your text into the Text box. Use the standard word processor controls to modify the 
font, style, and size of the text. The color of the text and the background can be changed 
using the color picker to the right of the text box.

The text can be changed at any time. The Video Preview window updates changes when you 
preview the event. By default, the background is transparent, but any color can be selected 
with the color picker.

Text box

Font style

Text effects

Media size
and duration
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Positioning the text

The Vertical and Horizontal text position lists allow you to roughly position the text on the 
screen. Fine tuning the exact vertical position for single-line titles can be accomplished by 
adjusting the Leading. Normally, Leading controls the spacing between lines of text, but for 
single lines of text it can move the line up or down on the screen, provided there is at least 
one blank line above the text. Spaces before the text can be used to fine tune the horizontal 
position. Tracking is used to set the spacing between individual letters.

To make the background transparent:

1. Click the Background tab in the Text dialog.

2. Slide the Alpha Control all the way to the bottom 
(100% transparent). This is the default setting.

The actual color is irrelevant since it is completely transparent. The text itself can also be 
made transparent in a similar way. To create a solid colored background, set the text to 100% 
transparent and select a background color that is 100% opaque. This is useful if you want to 
create a general background color for a project and allows you to fade to and from a specific 
color (instead of the default black).

To add a drop shadow:

1. Click the FX button ( ).

2. Click the Shadow tab.

3. Select the Draw Shadow check box.

4. Set the shadow’s attributes. Feather 
determines how soft the edge of the 
shadow appears and the Transparency 
slider can also be used to adjust the 
intensity of the shadow.

To use an outline effect:

1. Click the FX button ( ).

2. Click the Outline tab.

3. Select the Draw Outline check box.

4. Set the outline’s attributes.

100% opaque

100% transparent

A simple drop shadow can subtly emphasize a title.

The outline text effect is another good method for
emphasizing text. The Width and Feather controls
are used to create a simple outline or a diffuse glow. 
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Animating text

Text attributes can all be animated using the Begin/End buttons found in the Video FX 
dialog. By changing the Begin properties of an effect, and then changing the End properties 
to something different, VideoFactory smoothly animates the intervening frames. Many 
characteristics can be effectively animated, including leading and color, but the text message 
itself cannot.

To animate an effect:

1. Click the Begin button in the Video FX window on the tab of the effect you want to 
animate (e.g. the Video FX tab).

2. Adjust the parameters of the effect.

3. Click the End button.

4. Adjust the parameters for the end of the effect.

5. Click the Play button to preview the animation.

For more information, see Scrolling titles - Pan/Crop technique on page 72.
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Saving and 
Rendering 
Projects
VideoFactory allows you to save and render projects into many different multimedia formats. 
The chosen format is determined by how you want to deliver the media. When you render a 
VideoFactory project to a different format, your project is not affected, and a single project 
may be rendered in a number of different formats.

This chapter explains saving a project and using the Save As and Render As functions. In 
addition, you will find reference information for the rendering options available in 
VideoFactory.

Rendering projects

Rendering refers to the process of converting the VideoFactory project into a single new 
multimedia file and formatting it for the desired playback method: media player, Internet 
streaming media, CD-ROM, video tape, etc. The project file is not overwritten, deleted, or 
altered during the rendering process. You may return to the original project to make edits or 
adjustments and render it again later. The following table describes the formats available for 
rendering your VideoFactory project:

Format Name Extension Definition
RealMedia *.rm The RealNetworks standard for streaming media via the Web. This option 

renders both audio and video into one file.
Video for Windows *.avi The standard video file format used on Windows-based computers. This 

option renders both audio and video into one file.
Wave (Microsoft) *.wav The standard audio file format used on Windows-based computers. 
Windows Media Audio *.wma The Microsoft audio-only format used to create files for streaming or 

downloading via the Web.
Windows Media Video *.wmv The Microsoft standard used for streaming audio and video media via the 

Web.
QuickTime *.mov Apple QuickTime multimedia format.
Wave64 *.w64 A Sonic Foundry proprietary format that allows wave files that are 

unrestricted by file size.
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Rendering to an audio format

The audio-only formats that you can choose from are *.wav, *.w64 and *.wma. The file 
formats *.wav and *.w64 allow you to set the frequency, bit-depth, channel, and sample rate 
to which the VideoFactory project will be rendered. The *.wma format allows you to set the 
streaming qualities.

Rendering to a *.wma or *.wav file

The procedure is identical for each audio format to which you want the project rendered. 
The only difference is the selection from the File of type list on the Render As dialog. 

To render a VideoFactory project to one of these formats:

1. From the File menu, choose Render As. The Render As dialog appears. 

2. Select the drive and folder where you want to save the rendered file.

3. Type a new name in the File name field, if necessary.

4. In the Save as type drop-down list, choose Wave (Microsoft)(*.wav), or Windows Media 
Audio (*.wma).

5. If necessary, select any applicable check boxes.

6. Click the Save button. A small dialog box appears displaying the progress of the render 
and a status bar appears in the lower-left portion of VideoFactory. Upon completion of 
the render, your VideoFactory project is ready for distribution and playback.

Note: You may cancel the rendering process 
by clicking the Cancel button or the  button 
on the status bar.

Rendering to a video format

The process of creating a video file is known as rendering and can take quite a bit of time, 
depending on how many effects and transitions you have used, your CPU’s speed, and the 
final format you have selected. For longer movies, you might want to plan to render your 
movie overnight or when you are not using your computer.

There are four primary locations from where your final movie can eventually be played: on a 
VTR or VCR, a DV camcorder, on a hard drive on a computer, on a CD-ROM, and over the 
Internet. This final location directly determines the format of your movie. For more 
information, see Selecting a video format on page 119.

To render a VideoFactory project to an *.avi file:

Cancel
button

Status bar
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1. From the File menu, choose Render As. The Render As dialog appears. 

2. Select the drive and folder where you want to save the rendered *.avi file.

3. Type a new name in the File name field, if necessary.

4. In the Save as type drop-down list, choose Video for Windows (.*avi).

5. If necessary, select any applicable check boxes.

6. Click the Save button. 

A small dialog box appears displaying the progress of the render and status bar appears in the 
lower left portion of VideoFactory. Upon completion of the render, your VideoFactory 
project is ready for distribution and playback. It is also possible to create a full-quality render 
of only a section of a project. For more information, see Pre-render Video in Loop Region on page 
75. 

Rendering to a streaming media format

You may render a project with audio and video to a streaming media format. Streaming 
media can be used for presenting information via the Web. VideoFactory can render a 
project to either Windows Media or RealMedia players.

Rendering to an *.wmv, or *.rm file

This procedure is identical for each streaming format to which you want the project 
rendered. The only difference is the selection from the drop-down list. 

To render a VideoFactory project to one of these formats:

1. From the File menu, choose Render As. The Render As dialog appears. 

2. Select the drive and folder where you want to save the rendered file.

3. Type a new name in the File name field, if necessary.

4. In the Save as type drop-down list, choose Windows Media Video (.*wmv), or RealMedia 
(*.rm).

5. Select a template that fits your project.

6. Click the Save button. 

7. A small dialog box appears displaying the progress of the render and a status bar appears 
in the lower left portion of VideoFactory. Upon completion of the render, your 
VideoFactory project is ready for distribution and playback.
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Using rendering format controls and templates

VideoFactory has a number of templates that appear on the Render As dialog’s Template 
drop-down list to automatically configure a particular format for a particular destination. 
You may also save your own templates by clicking the Custom button. However, in many 
cases, a template may provide the best results for rendering your projects.

The following sections present and overview of each formats controls and template creation. 
Central to the process of creating a multimedia file from your project is the compressor or 
codec. A codec is simply the algorithm that is used to compress the media file.

Customizing a render

Every project (*.vf) has default settings that are used to determine the format of the final file 
created from a project. The settings are determined at the beginning of the project and can 
be changed at any time: from the File menu choose Preferences. For *.wav, *.w64, and *.avi 
files, the specific render settings can be fine tuned.

To customize the Render As settings:

1. From the Render As dialog, choose the format [e.g Video for Windows (*.avi)]. 

2. Click the Custom button and go to the Video tab.

• Select a Template from the list to automatically set up all of the settings on this tab. You 
can also create a custom template and save it for future use. The Description box 
summarizes the template properties.

• The appropriate frame rate and frame size are determined by the final destination of the 
movie. See the next section and your video capture card’s manual for more information.

• The Compression button opens a dialog to set up the exact codec used to compress the 
video. This is a very important process. In short, codec stands for COmpressor/
DECompressor and is the mathematical algorithm used to encode a video file. The codec 

Selected rendering
format

Selected template

Selected template’s
description

Click the Custom
button to change
control settings
or create/delete
a template
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directly determines the size and quality of the movie, as well as its compatibility with 
various playback devices. The final destination for the movie dictates the choice of codec. 
Some codecs have additional options that can be adjusted by clicking the Configure 
button.

3. Click OK to close the Custom Settings dialog.

4. Enter a name and location for the new file and click OK.

The customize settings that have been chosen here can be saved for future use. One of the 
most important reasons to save a new template is to save the specific compression codec 
used to create the movie, since this is not pre-determined by the project properties.

To save a new template:

1. Modify the parameters in the Custom Settings dialog.

2. In the Template drop-down list, enter a name for the new template.

3. Click the Save Template button ( ).

Changes cannot be made to the default template. To use the new template in the future, 
simply select it from the Template list in the Save As dialog. Custom Audio and Video 
settings are saved in the same template.

Note: To delete a template, choose it from the 
drop-down list and click the Delete button 
( ).

Custom rendering settings

The format of the final file that is created from a VideoFactory project can be set by clicking 
the Custom button in the Render As dialog. The Custom Setting dialog appears and has 
three tabs: Audio, Video, and Project. The Attributes drop-down list displays available choices 
dependent on the Format option that you choose.

The following sections describe and display each tab’s controls.

Audio tab - Custom Settings

• Format - You may choose one of the rendering codecs available from this drop-down list.
• Sample rate - The sample rate directly affects the audio’s quality. The sample rate is 

defined as the number of times a second that data is sampled in an audio file. It is similar 
to the concept of resolution in an image file. The higher the setting you choose, the 
better the quality, but the larger the file size.
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• Bit depth - The bit depth directly affects the audio’s quality. The bit depth is defined as 
how much data is used to save each sample (see above). The higher the setting you 
choose, the better the quality, but the larger the file size.

• Channels - A project may be rendered by channel types: Stereo, Mono, Multiple Mono, 
and Multiple Stereo.

Video tab - Custom settings

There are many possible formats to select from when creating a video file. Not all options 
are available for all types of video files. The particular compression chosen in the Video 
format list determines which of these options are available. For more information, see Selecting 
a video format on page 119.

Output properties

Final output properties can be adjusted when you save your final movie. From the File menu 
choose Save As, and choose a video file format (*.avi, *.qt, *.asf, or *.rm), click the Custom 
button, and go to the Video tab. Every project (*.vf) has default settings that are used to 
determine the format of the movie files created from that project. These default settings are 
overridden by the Save As Custom settings.

• Template - Select a template from the list to automatically configure all of the settings on 
this tab. You can also create a custom template and save it for future use. The Description 
box simply summarizes the template properties.

• Video size - This sets the final frame size and is largely determined by the final viewing 
destination of the movie.

• Frame rate - This sets the final frame rate of the movie.
• Video format - This is used to select the specific codec used to compress the video file. 

This is a very important process. In short, codec stands for COmpress DECompress and is 
the mathematical algorithm used to encode a video file. The codec directly determines 
the size and quality of the movie, as well as its compatibility with various playback 
devices. The final destination for the movie dictates the choice of codec. Click the 
Configure button to open a dialog to configure the details of how the codec will compress 
the video.

• Quality - Some codecs let you select a level of quality based on a relative percentage (%).
• Render alpha channel - If the format (e.g. some *.qt movies) supports it, the Alpha 

Channel information can be saved along with the movie file.
• Interleave every - In some cases, this helps to synchronize the audio and the video 

streams by interleaving the audio every X frames.
• Keyframe every - Compression keyframes can be added to improve the performance of 

the codec. This can increase the final file size.
• Data rate - Enter a value here to set a ceiling on the maximum data rate for the codec.
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• Don’t recompress if possible - Select this to allow VideoFactory to copy sections of a 
project that have not been modified without recompressing them. This saves time and 
maintains 100% of the quality of the original media files.

Project tab - Custom settings

There are many possible formats to select when creating a video file. Not all options are 
available for all types of video files.

• Image rendering quality - Higher quality settings result in longer rendering times. Good is 
the default.

• Interlace - Video that is displayed on a television monitor is interlaced. This means that 
every frame of video is actually composed of two fields, each of which is made up of half of 
the lines that make the final frame. These two fields are woven together in alternate lines, 
but which of the two fields is displayed first can be important. The interlace can be 
ignored for video that is going to be displayed on a computer: choose Progressive. For 
video on a television, most hardware supports Upper First. If the output is jittery or 
shaky, or your hardware’s manual specifies it, choose Lower First.

• Pixel aspect ratio - A pixel is a single picture element or dot on a television or computer 
screen. Computers display pixels as squares: 1.0. Televisions display individual pixels as 
rectangles: 0.909, 0.899, or anything other than square. Using the wrong pixel aspect 
ratio can result in distortions or stretching of the video. Select the aspect ratio for the 
final movie’s destination. Consult your hardware manual if you are in doubt about the 
appropriate ratio. The pixel aspect ratio is unrelated to the frame’s aspect ratio.

• Resample the frame rate of all video - This option resamples the frame rate for all source 
media files in a project that differ from the target frame rate of the final movie where 
necessary. This may or may not improve the quality of the final video, but will almost 
certainly increase rendering times.

Selecting a video format

When you create a final movie, you will find that there are literally dozens of formats to 
choose from, each having dozens of options. The destination of your final movie is the most 
important factor in selecting a format. Movies created for broadcast television must be of the 
highest quality, but for many other destinations, such as a CD-ROM or the Internet, you are 
going to have to sacrifice some quality when you render the file. Heavy compression may 
create visible artifacts in the video, such as when you create streaming video for the 
Internet. Every case is different and it is necessary to experiment a while to obtain the best 
results.
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VCR or television

If you are creating a movie that you want to send back out to a television, a VCR, a 
camcorder, or a DV device there is only one choice:

Use the same settings as the original video.

There is no way to improve upon the quality of your original video (as far as compression is 
concerned). If you have captured your video from a DV camcorder at 720X480 with 
29.97fps using a DV codec, then that is how you should set up your final movie. This is the 
only way to maintain 100% quality.

Computer

This can be the most complicated case because you have to decide exactly which computer 
it is going to be played back on, how fast it is, what software is installed, and how you are 
going to get it there. As CD writers become more common, the answer to the last question is 
easier, and this is a special case that will be dealt with in the next section. Your biggest 
concern with creating a video file is compatibility. When you create a movie, you must 
select a specific codec to compress the video. That same codec must then be used to view 
the movie. This is not a problem if you are viewing the movie on your own computer, since 
the appropriate codec is already installed. To ensure that your audience has the appropriate 
software, you should use a fairly universal codec. Intel Indeo, Cinepak, and Apple 
QuickTime are all widely available. Be careful not to use the latest version of these codecs 
unless you are sure that your viewers’ systems are up to date. These codecs are good for older 
computers and maintain pretty good quality, but they do not provide high compression 
ratios and the resulting files are rather large.

Internet

When video on the Internet is discussed, people almost always mean streaming. There two 
streaming media formats that come with VideoFactory: RealMedia (*.rm) and Windows 
Media Video (*.wmv). There is nothing particularly magical about streaming video, and the 
three rules of creating video files for the Internet are as follows: compress, compress, and 
compress. The smaller the file size the better, and this inevitably results in a loss of quality. 
There are two main places where you can save space: frame dimensions and frame rate. 
Typical Internet video files should be about 160X120 and should rarely exceed 320X240. 
This is not very big, and video with lots of detail will not translate well to this frame size. 
The frame rate should also be as low as possible, with 15fps being a good maximum. Fast 
action, pans, and moving backgrounds (tree leaves, ocean waves) will not compress well. 
Streaming media files need to be placed on a special Internet server in order to stream 
properly.
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Additive Dissolve, 93

ASR  See Envelopes

Audio plug-in dictionary, 85–88

AVI
bit-depth, 118
channels, 118
format, 117, 119
frame rate, 116
frame size, 116
rendering, 114
sample rate, 117
template, 117
video compression, 116

B

Black and White video FX, 105

Bypassing
track plug-ins, 85

C

Capturing video, 21

Clean Pre-Rendered Video, 75

Clearing the edit history, 48

Clock Wipe, 94

Color
track, 30

Converting format  See Rendering a project

Copying events, 41
time selections, 41

Creating a movie, 119

Cross Effect, 94

Crossfades, 46–47
automatic, 46

curve types, 47
curve types, changing, 47
manually setting, 47

Cursor movement, 35

Customer Service, 2

Cuts, 89

Cutting events, 41
ripple mode, 50

D

Deleting events, 45
ripple mode, 50
time selection, 46

Desktop shortcut, 9

Drop shadow, 110

Duplicating
events, 42

E

Edge trimming, 43

Edit history, clearing, 48

Editing
time vs. event, 36

Editing audio in external editor, 82

Editing Tools
Normal, 37
Selection, 37
Zoom, 30

Effects
modifying, 102
ordering, 103
removing, 102
video, 102

Envelopes, 65–66
adding points, 67



ii
Event, 65
fade in and out, 66
Fade Types, 66
setting points, 67
Volume (event), 65
volume fade curves, 67

Equalization plug-in, 87

Event properties
displaying names, 56

Event switches, 61–65
locking, 62
looping, 62
maintain aspect, 63
muting, 64
normalizing, 64

Event takes
adding, 55
changing active, 56
deleting, 57
displaying names of, 56
video, 55

Events
automatic crossfades, 72
copying, 41
crossfading, 46
cutting, 41
defined, 22
deleting, 45
duplicating, 42
envelopes (ASR), 65
grouping, 39–40
moving in time, 26
moving multiple, 27
moving single, 26
recording into, 79
ripple editing, 49
selecting multiple, 37
shifting the contents of, 44
splitting, 44
switches, 61
trimming, 43

Explorer window, 16
transport bar, 24
using, 23

view options, 23

F

Focus, 36

Frame by frame cursor movement, 36

G

General editing
event vs. file, 22

Grouping events, 39–40
clearing, 40

I

Ignore Event Grouping, 40

Images, working with, 72

Importing media from other projects, 54

Inserting media, 25

Installation, 8
system requirements, 8

Iris, 95

K

Keyboard commands
cursor placement, 35

L

Launch Video Capture, 21

Linear Wipe, 95

Locking events, 62

Locking events to track envelopes, 68

Looping events, 62

M

Marker
deleting, 53
naming, 52
navigating, 53
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placing and moving, 52

Marker bar, 13

Markers and regions, 52–54

Media files
auto preview setting, 24
inserting, 25
previewing, 24
video placement options, 25

Mixer
faders, 60
window, 16

Mixer window, 60

Mute button, 30

N

Normal Edit Tool, 37

Normalize
audio event, 64

O

Online Help, 10
accessing, 10
icon, 10
PDF manual, 11
Tip of the day, 11
via the web, 11
What’s This? Help, 10

Optimizing previews, 74

Ordering of effects, 103

Organizing tracks, 30

P

Pan/Crop, 69

Pan/Scan, 69

Pasting events, 42

PDF online manual, 11

Pitch shift, 54

Placing media

as takes, 26
same track, 26

Playback
scrubbing, 33

Plug-in chain
changing order, 103
creating on tracks, 83
saving presets, 85, 103

Post-roll, 80

Pre-render Video in Loop Region, 75

Pre-roll, 80

Presets, saving, 92

Preview fader
meter resolution, 60

Previews
optimizing, 74
partial, 75
rendering, 32
resolution, 74
transitions, 91

Project playback
entire, 32
time selection, 32

Projects, 19
saving, 21
starting, 19

Properties
events, 61
events, setting, 61
project, 20

Punch-in, 80

Push, 96

Q

Quick start, 19

R

RealMedia (*.rm)
rendering, 115
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Recording, 77–81
into a time selection, 78
into an empty track, 77
into an event, 79
into an event with time selection, 80
specifying storage folder, 81

Redo/Undo commands, 47–48
clearing history, 48

Region, 53
deleting, 53
naming, 54
placing and adjusting, 53
selecting, 54

Registering VideoFactory, 9

Registration Assistance, 1

Render As, 113

Rendering
custom settings, 116
RealMedia (*.rm), 115
selecting a video format, 119
Video for Windows (*.avi), 114
Wave (Microsoft)(*.wav), 114
Windows Media Audio (*.wma), 114
Windows Media Video (*.wmv), 115

Rendering a project, 113–115
audio formats, 114
controls and templates, 116
format options, 113
streaming formats, 115
video format, 114

Resolution and quality, 74

Ripple editing, 49–51
across all tracks, 50
cutting events, 50
deleting events, 50
Trimmer, 49

Ripple editing from the Trimmer, 49

S

Saving a project, 113
options, 21

Scribble Strip, 31

Scrolling, 29

Scrolling titles
Pan/Crop, 72

Scrub control, 15

Scrubbing, 33

Selecting
all members of a group, 40
multiple events, 37
range of events, 37
time range, 38

Selecting a video format, 119

Shadow, 110

Shifting the contents of an event, 44

Simultaneous Play & Record, 78

Slide, 96

Slide show, creating, 72

Sound editor program, 81–82
opening from VideoFactory, 82
setting up, 82

Spiral, 97

Split, 97

Splitting, 44

Squeeze, 98

Starting a project, 19

Starting VideoFactory, 8

Status bar, 15

Swap, 98

Switches, 61–65
Lock, 62
Loop, 62
Maintain aspect ratio, 63
Mute, 64
Normalize, 64

System requirements, 8
common, 8
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T

Takes, 55
adding events to, 55
deleting, 57
duplicating events and, 43

Technical Support, 2

Text, 109
background, transparent, 110
drop shadow, 110
positioning, 110

Time selection, 38
copying, 41
deleting, 46
recording into, 78

Timeline
moving events along, 26

Tip of the day Help, using, 11

Titles
scrolling - Pan/Crop, 72

Toolbar, 13

Track envelopes
changing volume curves, 67
deleting from track(s), 68
hiding on track(s), 68

Track FX, 83–88
adding via Plug-in Chooser dialog, 83
bypassing plug-ins, 85
creating a plug-in chain, 83
Equalization plug-in, 87
rearranging chain order, 84
removing plug-ins from chain, 85
saving preset chain, 85

Track Header, 14

Track View, 14

Track volume envelopes
adding points, 67
setting points, 67

Tracks
color, changing, 30
mute button, 30

Pan slider, 31
recording into, 77
scribble strip, 31
volume fader, 31

Transitions, 89
modifying, 92
window, 17

Transparency
backgrounds, text, 110

Transport bar, 14, 32
reference, 33

Trim, 43

Trimmer window, 16, 57
mark in and out points, 58
overview, 57
regions and markers, adding, 59
ripple editing, 49
working with, 58

Trimming events, 43

U

Undo/Redo commands, 47–48
clearing history, 48

V

Video capture, 21

Video Preview window, 17

VideoFactory
registering, 9
rendering a project, 113–115
starting, 8

VideoFactory overview, 12–18

View options, tracks, 29

Volume envelopes
deleting from track(s), 68
hiding on track(s), 68

W

Wave (Microsoft)
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rendering, 114

Web site
Help, using, 11

What’s This? Help, using, 10

Window Docking Area, 15

Windows Media Audio
rendering, 114

Windows Media Video (*.wmv)
rendering, 115

Z

Zoom, 99

Zoom Edit Tool, 30

Zooming, 29
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